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Before you begin

9is learner guide is based on the unit of competency BSBITU306 Design and produce 
business documents, Release 1. Your trainer or training organisation must give you 
information about this unit of competency as part of your training program. You can access 
the unit of competency and assessment requirements at: www.training.gov.au.

How to work through this learner guide
9is learner guide contains a number of features that will assist you in your learning. Your 
trainer will advise which parts of the learner guide you need to read, and which practice 
tasks and learning checkpoints you need to complete. 9e features of this learner guide are 
detailed in the following table.

Feature of the 

learner guide

How you can use each feature 

Learning content Read each topic in this learner guide. If you come across content that 

is confusing, make a note and discuss it with your trainer. Your trainer 

is in the best position to offer assistance. It is very important that you 

take on some of the responsibility for the learning you will undertake.

Examples and case 

studies

Examples of completed documents that may be used in a workplace 

are included in this learner guide. You can use these examples as 

models to help you complete practice tasks and learning checkpoints.

Case studies highlight learning points and provide realistic examples of 

workplace situations.

Practice tasks Practice tasks give you the opportunity to put your skills and knowledge 

into action. Your trainer will tell you which practice tasks to complete.

Video clips Where QR codes appear, learners can use smartphones 

and other devices to access video clips relating to the 

content. For information about how to download a QR 

reader app or accessing video on your device, please visit 

our website: www.aspirelr.com.au/help

Summary Key learning points are provided at the end of each topic.

Learning checkpoints There is a learning checkpoint at the end of each topic. Your trainer will 

tell you which learning checkpoints to complete. These checkpoints 

give you an opportunity to check your progress and apply the skills and 

knowledge you have learnt.
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Foundation skills
As you complete learning using this guide, you will be developing the foundation skills 
relevant for this unit. Foundation skills are the language, literacy and numeracy (LLN) 
skills and the employability skills required for participation in modern workplaces and 
contemporary life.

9e following table outlines speci*c foundation skills noted for your learning in this 
learner guide. 

Foundation skill area Foundation skill description

Reading  • Recognises and interprets textual information from a range 

of sources to determine and adhere to requirements

 • Applies strategies to self-correct and verify clarity and 

conformity of information

Writing  • Develops documents using required format, accurate spelling 

and grammar and terminology speci�c to requirements

 • Organises content to support purposes and audience of 

material, using clear and logical language

Oral communication  • Con�rms requirements with relevant personnel using speci�c 

terminology and listening and questioning techniques

Navigate the world of work  • Recognises and follows explicit and implicit protocols and 

meets expectations associated with own role

Interact with others  • Selects and uses appropriate conventions and protocols 

when communicating in a range of familiar work contexts

Get the work done  • Uses basic features and functions within applications to 

access, store, organise data and perform routine work tasks
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Before you begin

What do you already know?
Use the following table to identify what you may already know. 9is may assist you to work 
out what to focus on in your learning.

Topic Key outcome Rate your con�dence 

in each section

Topic 1 Select and prepare 

resources

1A  Select and use appropriate 

technology and software 

applications

 Con�dent

 Basic understanding

 Not con�dent

1B  Select layout and style of 

publication
 Con�dent

 Basic understanding

 Not con�dent

1C  Ensure consistency of design 

with company and/or client 

requirements

 Con�dent

 Basic understanding

 Not con�dent

1D Clarify format and style  Con�dent

 Basic understanding

 Not con�dent

Topic 2 Design the 

document

2A  Identify, open and generate �les 

and records
 Con�dent

 Basic understanding

 Not con�dent

2B  Design the document to maximise 

the presentation of information
 Con�dent

 Basic understanding

 Not con�dent

2C  Use a range of functions to design 

the document
 Con�dent

 Basic understanding

 Not con�dent

2D  Operate input devices  Con�dent

 Basic understanding

 Not con�dent
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Topic Key outcome Rate your con�dence 

in each section

Topic 3 Produce the 

document

3A Complete document production 

within designated time lines
 Con�dent

 Basic understanding

 Not con�dent

3B  Check documents for style and 

layout
 Con�dent

 Basic understanding

 Not con�dent

3C  Store and save documents  Con�dent

 Basic understanding

 Not con�dent

3D  Overcome basic dif�culties with 

document design and production
 Con�dent

 Basic understanding

 Not con�dent

Topic 4 Finalise the 

document

4A  Proofread the document prior to 

�nal output
 Con�dent

 Basic understanding

 Not con�dent

4B  Make modi�cations  Con�dent

 Basic understanding

 Not con�dent

4C  Name and store the document, and 

exit the application
 Con�dent

 Basic understanding

 Not con�dent

4D  Print and present the document  Con�dent

 Basic understanding

 Not con�dent
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Topic 1 
Select and prepare resources

To produce a business document, you must *rst select the most appropriate technology and 
so�ware application for the task.

You also need to consider the requirements of your organisation regarding information 
entry, layout, style, output, quality and storage. Organisations o�en have detailed 
speci*cations to make sure all documents are of an acceptable professional quality and in 
line with the organisation’s visual identity.

If you are preparing a business document for a client, you must ensure the design is 
consistent with the client’s requirements, and that the format and style are clearly speci*ed 
by the client before you produce the document.

In this topic you will learn how to:

1A Select and use appropriate technology and so�ware applications

1B Select layout and style of publication

1C Ensure consistency of design with company and/or client requirements

1D Clarify format and style
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All organisations design and produce business documents to communicate and organise 
information. 9ese documents can be for internal or external clients and contain 
information about all aspects of the business.

You need to be able to identify the diAerent types of business documents within your 
organisation, which may include the following.

Newsletters A newsletter is a document that is published periodically. 

It can be used to make an announcement, such as the 

appointment of a new staff member, circulate news, such as 

an article on current research the organisation is doing, and 

may also contain photographs and text. Email newsletters, 

often referred to as e-news, are an excellent way to 

communicate with internal and external clients. They are also 

a good way to save on postage and paper, though you must 

ensure that you comply with the Australian regulations for 

sending bulk emails. 

Client databases A client database stores information about customers in a 

structured way. It usually has the names and addresses of 

customers and details of any products and services they 

may purchase. A database uses �elds, records and tables to 

organise this information. It allows an organisation to store, 

modify and extract information (such as a telephone number) 

about one client or many. A client database is a powerful tool 

and it might be your responsibility to design and use one.

Proposals A proposal is a business document that outlines how an 

organisation can produce a product or service for another 

organisation. For example, if an organisation wants to supply 

a cleaning service, it would outline the details of its service 

in a proposal and submit it to the potential client. A proposal 

can also be used to apply for a government grant. In this 

case, it would contain information about why the grant is 

needed, what purpose it will serve and how much money is 

required. A proposal is always a written offer to accomplish 

an objective in a particular way for �nancial gain. 

Reports A report is a written document that describes the �ndings 

of an individual or group. For example, a research of�cer 

has to write reports that describe what their research has 

discovered. A report can be used to communicate information 

to internal and external clients. Reports are one of the most 

common types of business documents. Whatever your role, 

you will most likely have to write or read an organisational 

report.

1A Select and use appropriate technology 
and software applications
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Topic 1
Select and prepare resources

Accounts 

statements

An accounts statement contains information about 

the speci�c assets, liabilities and fund balances of an 

organisation. It helps an organisation understand how well 

it is doing �nancially. Accounts statements are often used 

to make decisions. For example, a �nancial statement that 

details the pro�tability of a product, would be used to make 

a decision about whether to continue with the production 

of that product or not. Accounts statements are needed for 

taxation purposes. When the taxation department audits 

an organisation, it needs to produce all of its accounts 

statements.

Project reviews A project review describes the progress of a project. A project 

can run for 12 months or longer and it needs to be reviewed 

at certain intervals to make sure that it is on budget and 

on time. Project reviews are usually written by the project 

manager and presented to management. They are then 

used as a basis for decisions about the project. For example, 

management might decide to hire more people if the review 

shows that the project has met with an unexpected workload 

and is running behind time. 

Web pages A web page is a page from the web (internet). It is displayed 

using a web browser and may contain text, illustrations, 

motion graphics and interactive media. It may also contain 

hypertext links to allow navigation from one page, or section, 

to another. Web pages are used extensively by organisations 

to advertise products and/or services. They are also used 

to help clients make an online purchase. This is called 

e-commerce.

Use business technology
Every organisation uses some sort of technology. 
It is important to know what is available in your 
workplace and to use it appropriately. You might 
need to make choices about:

• business equipment

• business so�ware.
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Business equipment

Most organisations depend on business equipment to operate. 9e most common piece of 
equipment in the o1ce is the computer, which is used to input, process and output business 
information.

You might also have to use printers, scanners and photocopiers. Descriptions of the 
functions of each of these types of business equipment are provided here.

Printers

A printer is a device that produces a paper copy of the information displayed on the monitor of 

your computer. There are many different printers available. The main differences are the speed 

at which material is printed, the quality of the print, the options available and the cost.

Your organisation may have several different printers and you will have to make a decision 

about which one is most appropriate for your use. For example, does your document need to 

be printed in colour, or black and white? Do you need to print on one side or both sides of the 

paper?

Printing usually involves a number of decisions. Before you press the ‘print’ button, you need to 

consider the speci�c requirements of your task, the software application you are using and the 

capabilities of your printer. You may have various options for printing. For example, in Microsoft 

Project you can choose to print a project overview, a summary of tasks or just the milestone 

tasks. If you are printing a spreadsheet, you may wish to print it at actual size, or scale it down 

to �t on one page. 

Scanners

A scanner is a device that produces a digital version of a hard-copy document. For example, 

if you scan the hard-copy version of a report into a computer, you can send the information 

electronically or make alterations before reprinting.

A scanner can be a useful piece of equipment if you are producing a newsletter, catalogue or 

any other document containing photographs, illustrations, maps or handwritten material. It 

can copy a selected image into a graphic �le on a computer. This can then be imported into 

the document you are working on. The image can be re-sized, if you need to make it smaller, or 

cropped if you only want to keep part of the image.

There are two primary types of scanner:

 • a +at-bed scanner that is connected to your computer but stands alone

 • a scanner that is incorporated into a fax machine and/or photocopier.

A +at-bed scanner can scan most images as it caters for many different sizes, from a 

photograph to a map. The other type of scanner is not as +exible and is most suited to single-

sheet documents up to A4 size.

Photocopiers

Photocopying is a process that makes a paper copy of a document, or any other visual image, 

quickly and cheaply. If an organisation needs multiple copies of a document, a photocopier is 

the most suitable equipment to use. Documents such as price lists, product information and 

internal reports often need to be copied and sent to customers, or stored for employee use. 

Because people use photocopiers so frequently, it has prevented most of�ces from becoming 

totally paper free. Try to use the photocopier in your organisation wisely and save paper.
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Topic 1
Select and prepare resources

Business software

Wherever you work, you will have to use business so�ware, which is made up of a series of 
instructions that make a computer do tasks. So�ware is also called a program.

9ere are two major categories of so�ware: system so�ware and application so�ware. 
System so�ware supports the production or execution of an application program but is 
not speci*c to any particular application. An example of system so�ware is the Windows 
operating system. Application so�ware performs a more useful function, as it processes or 
manipulates data. Examples of application so�ware are Microso� Word, Access and Excel.

Here are the main types of application so�ware that are used in a business environment.

Business software applications

1 Word-processing software

Word-processing software is used to create, store and print documents. You can 

type and edit text, and insert graphics, to create documents that can be easily 

saved. Any document that involves written information is usually created using 

word processing software.

Word-processing software can save documents in multiple output formats 

depending on the user requirements. Typically these are hard-copy printouts, 

but web-based formats such as hypertext mark-up language (html) can be used 

or portable document formats (pdf).

A commonly used word-processing software is Microsoft Word.

2 Spreadsheet software

In accounting, a spreadsheet is a large sheet of paper that displays the �nancial 

position of a company. It spreads, or shows, all of the information (such as 

costs, income and taxes) on a single sheet of paper and organises information 

into columns and rows. Spreadsheet software records and processes 

information in the same structure. For example, a spreadsheet showing 

accounting transactions could group data in areas such as accounts payable, 

accounts receivable and payroll. The data can then be manipulated by a formula 

to give a total or sum.

Spreadsheets present a lot of information in an easy-to-read format, and can 

help decision-makers see the big picture of an organisation.

A commonly used spreadsheet software is Microsoft Excel.
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3 Database software

A database is an organised body of related information. Database software 

organises information in such a way that it can quickly select the desired piece 

of data.

Data is organised by �elds, records and tables.

A �eld is a single piece of information; for example, a client’s surname.

A record is one complete set of �elds; for example, a client’s complete name and 

address.

A table is a collection of records; for example, every client’s name and address.

A database allows an organisation to store, modify and extract information 

about customers and products. For example, you can extract information about 

all clients who live in a certain area from a database of client details.

A commonly used database software is Microsoft Access.

4 Presentation software

Presentation software is frequently used by presenters to give a clear visual 

display of the points covered in a talk. It can also be used to create slide shows 

or multimedia presentations.

It usually includes three major functions:

 • The slide show system to display content

 • An editing tool that allows text to be moved around from slide to slide

 • A graphics system for quickly drawing charts and graphs

A commonly used presentation software is Microsoft PowerPoint.

5 Accounting software

There are many commercial accounting software packages available. 

These enable �nancial records and reports to be recorded and generated 

electronically. Compared to a manual accounting system, commercial 

accounting software enables much more extensive and reliable record keeping 

and a vast array of reporting options to be generated readily.

Some organisations use a commercially available accounting package such as 

Mind Your Own Business (MYOB) or QuickBooks, which they tailor to suit their 

own organisational requirements. Some organisations use accounting software 

speci�cally designed for use within the particular organisation type, such as 

schools or hospitals. 
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Choose appropriate technology
You need to choose appropriate technology for each 
job. Always start with the outcome. What do you 
want to produce? 9e type of technology you use 
should always depend on the types of documents 
you want to produce. For example, you would 
use presentation so�ware to develop a slide show 
presentation. It would not be appropriate to complete 
this task in Word.

A single job can sometimes require a selection of 
business so�ware and business equipment. For 
example, you might be asked to design a slide show 
presentation for your manager and supply a hard 
copy of the speech. To achieve this you would need to 
use both presentation and word-processing so�ware. 
You would also need to use a printer to print out the speech.

Practice task 1

Imagine that you have to produce the documents in this table. Fill in the type of business equipment 

and/or software you would need for each one.

Type of document Business equipment/software

A hard-copy version of a report containing 

text and �nancial statements. Some of the 

information for the report is only available in 

hard copy and some alterations still need to be 

made.

An e-newsletter, including text and 

photographs, which also includes statistical 

information extracted from client details.

A proposal to another organisation, to be 

presented in the boardroom by your manager 

to the organisation’s owner. Your manager 

requires some notes in hard copy.

A database of client information.
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9e layout and style of a publication is critical to its impact on the reader, just as the 
contents are.

If a business document is di1cult to read because of poor design features, its contents are 
less likely to make any impact on the reader of the document. 9e reader may be distracted 
by poor layout instead of concentrating on understanding the content.

Layout and styles
9e layout and style of a publication will depend on what the organisational requirements 
are for the particular document type. Any document you create must *t the speci*cations 
of your organisation. It is a good idea to *nd a sample before you start. By looking at the 
sample and asking about the speci*cations, you should be able to work out exactly what 
layout is required.

For example, your organisation might have a preferred layout for business reports, which 
will require using the following guidelines for structure and format.

Structure

 • Begin with an outline.

 • Follow this with bullet points 

covering the major issues.

 • End with a report summary.

Format

 • Use a particular font type and 

size (such as Times New Roman 

12 pt).

 • Use a certain colour and style 

for headings (such as black and 

bold).

 • Make sure paragraphs are 

double-spaced so the report is 

easy to read.

1B Select layout and style of publication
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Minutes of meetings

9e full block style of minutes of meetings is shown below.

Information contained in minutes 

 • Type of meeting, place, date and time

 • Name of the Chairperson and names of persons present (Chairperson 

�rst, then in alphabetical order)

 • Apologies

 • Con�rmation of Minutes of the previous meeting

 • Matters arising from the Minutes of the previous meeting (if any)

 • Other matters such as reports, correspondence, business discussion

 • The time the meeting was closed

 • Space for the Chairperson to sign and date (to be completed during the 

next meeting)

Example: meeting minutes

Minutes of the eighth Annual General Meeting of the North 

Sydney Squash Club held at the club rooms, McLaren Street, 

North Sydney, on Tuesday 16 February 2016 at 7.30 pm

Present

Cameron Strong (Chairperson) 

Diane Crookes 

Harold Dentener 

Barbara Barry (Secretary)

Apologies

Apologies were received from Carol Burnett.

Minutes

Minutes of the seventh Annual General Meeting were read, approved and signed as a true and 

correct record.

Election of of�cers

It was resolved that the present of�cers be re-elected for a further season. Moved by Harold 

Dentener, seconded by Diane Crookes.

Subscriptions

It was resolved that subscriptions be increased by 10 per cent for the new season. Moved by 

Barbara Barry, seconded by Harold Dentener.

Tournament entries

It was agreed that tournament entries are very high and it was suggested that Cameron Strong 

raise this point at the next regional meeting.

The meeting concluded at 8.30 pm.

Chairperson:       Date:  
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Fax form

A fax form is used to send information to another department, branch or company through 
a facsimile (fax) machine. Field codes can be inserted (by pressing Ctrl F9) to enter variable 
information.

A cover sheet is the *rst sheet of the fax and contains:

• who the fax is to – the name of person and company

• who the fax is from

• the fax number you are sending the fax to

• the date of the fax

• your fax number (this is o�en printed at the top of the sheet)

• the number of pages including the cover, so the receiver knows how many pages have 
been sent.

Example: facsimile

Facsimile

To:  

Company: 

Fax:  

From:  

Date:  

Subject:

No. of pages: 

Of�ce manager  

Robert Yates & Co Ltd

378 9056

Julia Donaldson

12 May 2016

Installation of Software

(incl. cover) 1

Further to the purchase of your computer equipment yesterday, I wish to con�rm that I will be at 

your of�ce at 9.00 am tomorrow to install your Of�ce 2013 program.

Templates

9ere are many templates for business forms which 
can be downloaded from Microso� O1ce Online. 
Go to the website http://o1ce.microso�.com and 
select Templates. 9ere you can download a variety 
of pro-forma documents such as agendas, brochures, 
business cards, faxes and Jyers. Alternatively, in 
Microso� Word 2013, click on the File tab, select 
New and click through the selected searches to *nd 
the template you want. Select the template and click 
Create on the right-hand side to download.
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Select and prepare resources

Identify organisational requirements
Most organisations have requirements for the layout 
and style of documents. Meeting these requirements 
helps achieve a professional quality and ensures all 
documents are produced in a consistent format. You 
should identify these requirements before you design 
your document.

9e information itself o�en has to follow a certain 
format to be accepted. For example, postcodes must 
have four numbers, customer IDs must have the right 
combination of numbers and letters, and customer 
balances must have a currency format.

9e layout and style requirements of a publication 
may also be inJuenced by factors such as budget 
restrictions. For example, a *xed budget may mean that annual reports can’t be printed 
in colour or presented in binders. Another example would be a company preparing a 
promotional brochure using plain paper rather than heavy-duty card or glossy paper.

Organisational quality assurance and/or procedures manuals also dictate the layout and 
style applicable to business documents. For example, there may be documented procedures 
within your organisation that are about having a consistent layout of agendas, business 
letters, minutes of meetings or annual reports and using a speci*c style of presentation.

Example: report speci3cations

This report has been developed to �t certain design speci�cations.

Report on paper usage

Overview

Paper usage has reached an all-time high with twice as much paper 

being ordered per month as was ordered at the same time last year. 

This report outlines strategies to reduce paper wastage.

Main points

 • All printers purchased are to have double-sided printing 

capacity.

 • Printing from all terminals is to be tracked by the printer and 

each department made aware of its monthly paper usage.

 • Budget for paper consumption is to be reduced.

 • Staff are to communicate using email rather than written memos.

Summary

Our goal is, with the assistance of these changes, to bring about a 25 per cent reduction in paper 

usage. Up-to-date �gures and costs for paper consumption will be released in one month.
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Practice task 2

Look at the report in the previous example and answer the following questions.

1. The main sections in the report are easy to read. How was this achieved?

2. The report has three sections. What are they?

3. The overview of this report has to stand out from other sections. How was this achieved?

4. What do you observe about the layout of the document?
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Inputting information into the computer is just the beginning. Once you have entered 
the relevant data, you must organise the content and structure. 9is is called designing a 
document and each task will be diAerent. It all depends on the type of document you are 
working on and the requirements of your workplace.

9e document you are designing needs to be prepared using consistent design principles in 
line with organisational or client requirements. Consistent design ensures that the layout 
of the content Jows smoothly and the *nal presentation is professional. Consistent design 
techniques should be used in the following features of your document.

Headings

Use a font and font size for a major heading so it will inform the reader of the focus of the 

page/document. Headings should be large enough for easy reading and can be centred, left 

aligned or right aligned. There is usually only one major heading but sometimes there is a 

major subheading also (which should be in a smaller font size).

Subheadings are a transition from the major heading to body text and make it easy for readers 

to locate information. Subheadings are usually in bold and in a smaller font size than the major 

heading/s. 

Lists

Numbered and bulleted lists can have less spacing between items and more above and below 

the list.

Borders and lines

Borders and lines can be added to documents. Again, spacing must be consistent – if you 

insert a 12 pt space (or one Enter) before one line, then the next line must have the same 

amount of spacing used.

Spacing

Variations can occur; for example, the spacing between a bulleted list could be reduced to 3 

pt or 4 pt if it is necessary to �t text on a page, or spacing after subheadings could be reduced. 

Punctuation and capitalisation

It is important that punctuation is consistent throughout, including such things as the use of 

single or double quotation marks, and whether items in a list are separated by a comma or 

not. Capitalisation in headings must be consistent; for example, in this unit only the �rst letter 

of headings are capitalised. This style of capitalisation is called minimal capitalisation. 

1C Ensure consistency of design with 
company and/or client requirements
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Paragraphs and alignment

Paragraphs help break up the text and keep ideas organised. Some paragraphs are typed 

so they start from the left margin of the page. This style of paragraph is called left aligned. 

Others are indented so each new paragraph starts a few spaces in from the left margin. Like 

headings, paragraphs may be aligned to the left, to the centre or to the right. They may also 

be justi�ed, which means that the text and often the spaces between words are stretched to 

create a consistently shaped block of text.

Margins, indentations, headers and footers

Ensure margins are the same, as well as the indentation of paragraphs. Use the headers 

and footers features of Microsoft programs to ensure consistency of headers and footers 

throughout your document. 

Design tips

Following are some more design tips.

Experiment

Spend time experimenting with different document layouts, if you can. Word-

processing programs make this easy to do; you can save your attempts with 

different �le names until you arrive at the ideal layout or use the Undo function. 

The proportions of the publication need to be considered so that graphics and 

text are well balanced on the image, and the impact of both is considered.

Be appropriate

Ensure appropriateness; that is, that the document relates to the content of the 

publication and the people who will be reading it. For example, an advertisement 

for a clothing sale would have a totally different appearance to a company 

report.

Proofread

Proofread (check) the document for mistakes. You can use the spellcheck in 

your word-processing process but it’s also a good idea to get someone to review 

your document. You should proofread the text and check that the style of the 

document is consistent with your workplace’s house style.
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Practice task 3

This document has numerous design and layout inconsistencies. Highlight the inconsistencies and 

explain why you think it is an inconsistency.

Cardiopulmonary resuscitation (CPR)

If someone is unconscious, check for signs of breathing.

Dial 000 for an ambulance.

If person is not breathing:

Turn them on their back

Tilt their head and lift their jaw

 • Ensure the airway is open.

 • Pinch nose closed.

 • Take a deep breath and seal your lips around the person’s mouth.

 • Give two breaths

 • See if the chest rises.

 • Remove your mouth and allow the chest to fall.

o Start chest compressions

Position one hand on the centre of the chest

Grasp wrist with other hand

Compress breastbone 4 to 5 cm or one third the depth of the chest

> Continue with 2 breaths to 30 compressions

> Rate of compressions is 100 per minute or almost 2 per second

dO nOT sTOP uNLESS:

Help arrives

Person breathes normally

You’re totally exhausted.
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You have already learnt about the importance of the consistency of the format and style of 
the business document you are preparing. Looking at an existing sample of a document 
previously created is a good place to start with your preparation. 9en once you have 
developed a plan it is advisable to clarify your plan with the end user of the document 
or with someone who can represent them. You need to be clear about the purpose of the 
document and the audience you are targeting.

Purpose and audience
Before designing a document, you need to think about who you are communicating with 
and what information, or message, you are trying to convey.

You should always clarify the purpose of the document. What type of document is it? What 
is it meant to do? It may help to put these thoughts in writing; for example, ‘9is document 
is a presentation to outline my work progress.’ A single sentence stating the purpose of your 
document can help to focus your writing.

You also need to clarify the intended audience of the document. Is it for a large or small 
group? Is it for your colleagues or external clients? Knowing and understanding your 
audience will inJuence the way you design the document. It should also inJuence the way 
you portray your intended message. You need to think about what you want your audience 
to know, what your audience needs to know, and what your audience already knows.

Here are some principles of design to keep in mind.

The principles of good design, when creating a document

 • Distinguish primary (important) from secondary (additional) ideas.

 • Set off examples from the text.

 • Draw attention to headings.

 • Draw attention to certain parts of a document.

 • Make information easy to �nd.

 • Arrange every element to lead the eye progressively from one part to the 

next.

 • Provide visual relief by including artwork and white space.

 • Use a consistent style throughout the document.

Clarify format and style

A lot of time can be wasted by not clarifying the format and style of the proposed document 
with the person requesting the publication. It may be that they need guidance as to the 
principles of good format and design. Show them samples of other publications and explain 
the options available for diAerent styles. Ask them questions about what they have in mind 
and make constructive suggestions for improvements. Be certain to clarify exactly what you 
have discussed and agreed on.

1D Clarify format and style
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Example: report design

The following example shows the same report designed in two different ways.

Report on paper usage

Overview

Paper usage has reached an all-time high 

with twice as much paper being ordered 

per month as was ordered last year. This 

report outlines strategies to reduce paper 

wastage.

Main points

 • All printers purchased to have double-

sided printing capacity.

 • All printing to be tracked by the printer 

and each department made aware of its 

monthly paper usage.

 • Budget for paper consumption to be 

reduced.

 • Staff to communicate using emails 

rather than written memos.

Summary

It is hoped that these changes will bring 

about a 25 per cent reduction in paper 

usage. Up-to-date �gures and costs for 

paper consumption will be released in one 

month.

Report on paper usage

Overview

Paper usage has reached an all-time high 

with twice as much paper being ordered 

per month as was ordered last year. This 

report outlines strategies to reduce paper 

wastage.

Main points

All printers purchased to have double-sided 

printing capacity.

All printing to be tracked by the printer 

and each department made aware of its 

monthly paper usage.

Budget for paper consumption to be 

reduced.

Staff to communicate using emails rather 

than written memos.

Summary

It is hoped that these changes will bring 

about a 25% per cent reduction in paper 

usage. Up-to-date �gures and costs for 

paper consumption will be released in one 

month.
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Practice task 4

Read the two reports from the previous example.

1. Which report is easier to read?

2. Describe the design principles used in the �rst report.

3. Describe any design problems you can identify in the second report.

Summary

1. Business documents communicate and organise information.

2. Select appropriate technology and so�ware applications to produce the business 
documents your organisation requires.

3. 9e layout and style of a document is critical to its overall appearance and clarity. It has 
to be prepared in accordance with organisational requirements.

4. 9e document design must be consistent with organisational or client requirements and 
have all the features of basic design principles.

5. Prior to preparing the documents, clarify the format and style with the person 
requesting its publication.
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9is learning checkpoint allows you to review your skills and knowledge in selecting and 
preparing resources.

Part A
1. Choose four types of business documents from the seven listed in this topic. Write one 

paragraph about each document, including the purpose of each document. 

Learning checkpoint 1 
Select and prepare resources
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2. Four pieces of business equipment are available in an organisation:

• A computer

• A scanner

• A photocopier

• A printer

Decide which piece(s) of equipment to use in each situation in the following table. 

Situation Equipment needed

A hard-copy report needs to be reproduced 

10 times.

A hard-copy photograph needs to be put 

into an e-newsletter. 

A proposal needs to be written and 50 

copies made.

A hard-copy accounts statement needs to 

be updated and emailed to an accountant.

Part B
Read the case study, then answer the questions that follow. 

Case study

Moira works as an executive assistant. Part of her role is to prepare documents for her 

manager, who is going to make a presentation to all staff next week. He has asked Moira to 

develop the presentation, including the presenter notes.

Moira found the organisation’s style guide for developing presentations and designed the 

information accordingly. She used consistent design principles throughout the document. She 

prepared presenter notes and made a hard copy. The presentation included some photographs 

that Moira had to scan before she could include them on slides.

1. List the types of business equipment that Moira would have used to design the 
presentation.
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2. List the types of business so�ware that Moira would have used to design the 
presentation.

3. How did Moira make sure that the style of her presentation met with the requirements 
of her organisation and that she used consistent design principles throughout the 
document?

4. Explain why multiple business technologies are usually needed to develop a business 
document.

Part C
Read the case study, then answer the questions that follow.

Case study

Eleni works as an of�ce administrator in a large organisation. One of her duties is to design 

presentations. These are sometimes for the board of directors and sometimes for her 

colleagues.

One day Eleni was asked to put together some information describing the progress of a new 

project. Eleni assumed this information was for her colleagues. She wrote a detailed report 

outlining the project’s progression.

When the time came for the document to be used, Eleni discovered that it was for the board of 

directors, who had little knowledge of the new project! They prefer visual presentations rather 

than the text-based documents, as they don’t have the time to read them. Eleni had no time to 

change the document.
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1. Eleni did not design the document for the intended audience. What might the 
consequences be?

2. Eleni should have clari*ed two points before beginning her task. What are the two 
points?

3. Explain why it is important to clarify the purpose and audience of a document before 
design begins.
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To design a business document you need to consider a number of things. First, you have to 
input some information. 9is is usually done using a keyboard and mouse, and sometimes 
the numerical keypad on your keyboard and/or a scanner. It is important to use these 
devices both quickly and e1ciently.

It is also important to follow some basic design principles. If you do this, your documents 
will always be visually distinct, attractive and easy to understand. Identifying the purpose 
and intended audience of your document will also help you design a document that 
communicates its message in the right manner.

Formatting the document is also important. 9ere are a number of so�ware functions that 
can make this task a lot easier.

You may also need to access other *les and records to create your document. You need 
to know how to identify, open and generate these *les and records according to task and 
organisational requirements.

In this topic you will learn how to:

2A Identify, open and generate *les and records

2B Design the document to maximise the presentation of information

2C Use a range of functions to design the document

2D Operate input devices
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Business documents are developed from records  
that are stored in *les. A record is a piece of 
information about an organisational issue; for 
example, photographs, database records, accounts 
statements or written reports. A *le is a collection of 
similar records; for example, a collection of board 
meeting minutes or accounts statements. A report 
may contain information gained from accounts or 
departmental records.

Manage 3les and records for 
document use
DiAerent organisations have diAerent records and 
*les. It all depends on the information needs of the workplace. 9e important thing is that 
they are properly managed. Organisations need to create, update and store their *les in 
suitable locations so that they can be easily accessed and maintained.

Managing records and *les properly improves the e1ciency and productivity of the 
workplace. It also safeguards vital information and provides better support for management 
decision-making.

To successfully manage records and *les, you need to be aware of:

• your responsibilities

• how to create a new record or *le

• how to update a record or *le.

Your responsibilities
If one of your duties is to manage records and *les, you need to be aware of how your 
organisation wants you to organise, create, maintain and store them.

It is also important to know the subject and purpose of the record or *le. For example, if 
your organisation has a *le full of records about so�ware purchases you should know why 
that information is needed. 9e so�ware *le may be part of the organisation’s assets register 
or it might need to be located in the same place as the other so�ware records. If they are 
*nancial records, such as invoices, they might need to be kept for taxation purposes.

You should be aware of any security requirements regarding records and *les. For example, 
is the *le con*dential? Who is authorised to have access? You also need to know where 
records and *les should be stored, so that they can be easily retrieved.

2A Identify, open and generate 3les and records
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Create a new record or 3le
Organisations constantly require new information 
about their clients or products. To generate this new 
information you need to be able to create new records 
and *les. 9ese might include:

• a new record for an existing *le

• a new *le and new records.

If you are naming a new *le you must consider the 
names of *les that already exist. 9is is the only way 
to ensure consistency and prevent duplication. Your 
organisation may have a *le classi*cation system that 
sorts *les by codes or ID (identi*cation) numbers. If 
this is the case, you may need to generate a new code 
or ID number for the new *le.

File and record information

Once you have created a new *le, you need to make sure you have all the relevant records in 
the *le and that they contain adequate information. All *les and records are created because 
of an organisational need and if they do not ful*l this need they may not be useful.

It is also important to place records in the appropriate *le and store the *les in the 
right place, so that everyone can access and retrieve them as required. 9is might mean 
registering the *le on the company’s database so that employees can search for and *nd 
it easily.

When creating records and *les you also need to think about the diAerent types of 
information you are dealing with. Make sure that information meant only for you is kept 
separate from o1cial information.

Practice task 5

The steps in this table are for creating records and �les. Number the steps from one (1) to six (6), 

where one is the �rst step and six is the last. Explain why you have put the steps in this order.

Steps for creating records and �les

Keep personal records and �les separate from of�cial records and �les.

Place �les where they can be easily accessed.

Create records that contain appropriate information. 

Identify a need for creating a new record or �le.

Register the �le on the organisation’s database.

Name records and �les to ensure consistency with existing documents and to 

prevent duplication.
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E1cient entry of information helps to streamline the  
overall process of document preparation. If you have 
all of the information you need at hand prior to 
commencing, you can sort it into a logical sequence.

Set aside a realistic amount of time to prepare 
your document. If you rush or stop and start the 
preparation frequently, you are more likely to make 
mistakes and the document may not Jow in a logical 
sequence.

In order to maximise the presentation of information 
you might consider applying or customising a 
particular theme for your document. 9is entails 
formatting an entire document with a theme to 
give it a professional and modern look. A document 
theme is a set of formatting choices that include a set of theme colours, fonts (including 
heading and body text fonts) and eAects (including lines and *ll eAects).

Programs such as Microso� O1ce Word, Excel and PowerPoint provide several prede*ned 
document themes, but you can also create your own by customising an existing document 
theme, and then by saving it as a custom document theme. Document themes are shared 
across Microso� O1ce programs so that all of your documents can have the same, 
uniform look.

Enter information e7ciently
9ere are two main components to entering information e1ciently. 9e *rst is making 
sure you have everything you need at hand, so you don’t have to stop and search for more 
information. 9is is a way to maximise your e1ciency as the author of the document. 
Sometimes you might even be able to copy information from another business document. 
If you were compiling a report on expenditure, for example, you might be able to copy key 
*gures directly from the accounting package or records spreadsheet.

9e second is ensuring that the information is presented in the most appropriate way, so 
that a reader of your document does not need to stop and think in order to understand it. 
9is is a way to maximise the e1ciency of the document for the reader.

Allow a realistic amount of time
It is essential that you allow a realistic amount of time to prepare your document.

Instead of making a plan for the best-case scenario, you should consider worst-case 
scenarios you can’t control; for example, the printer or photocopier breaks down, or 
someone else needs to use them at the same time.

If adequate time is not allowed, then:

• the document will not be prepared in time

• important information may be le� out

• incorrect information will be included; for example, the sales *gures for the wrong 
quarter.

2B Design the document to maximise 
the presentation of information
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Maximise the presentation of your document
Many organisations have a particular corporate style that they use for all their business 
documents. 9is ties the organisation’s documents together and makes them look 
professional when presenting to clients and to suppliers.

Some aspects of the presentation that might be mandated by your organisation:

• 9e font (and size) of text in the document

• 9e colour, size and font of headings

• A cover sheet (for word documents) or background image (PowerPoint)

• Format and colour schemes for images and tables

Design techniques
You can change the document theme that is 
applied by default in O1ce programs by selecting 
another prede*ned document theme or a custom 
document theme. Document themes that you 
apply immediately aAect the styles that you can 
use in your document. A style is a combination of 
formatting characteristics (such as font, font size and 
indentation) that you name and store as a set. When 
you apply a style, all of the formatting instructions in 
that style are applied at one time.

Apply a document theme

In order to apply a prede*ned theme, the following steps should be taken.

1. In Word or Excel: on the Design tab, in the Document Formatting group, choose 
�emes.
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2. In PowerPoint: on the Design tab, in the �emes group, click the document theme that 
you want, or click More to see all available document themes.

In PowerPoint, you can apply a document theme to all slides, to selected slides only 
or to the master slide. Right-click the document theme, and then click the option that 
you want.

3. To apply a prede*ned document theme, click the document theme that you want to use 
under O�ce.

4. To apply a custom document theme, click the document theme that you want to use 
under Custom.

Note: Custom is available only if you created one or more custom document themes. For 
more information about creating custom document themes use the help feature on the 
Microso� program you are using.

5. If a document theme that you want to use is not listed, click Browse for 9emes to *nd it 
on your computer or a network location.

6. To search for other document themes on O1ce Online, click Search O1ce Online.

Customise a document theme

To customise a document theme, you start by 
changing the colours, fonts or line and *ll eAects 
that are used. Changes that you make to one or more 
of these theme components immediately aAect the 
styles that you have applied in the active document. If 
you want to apply these changes to new documents, 
you can save them as a custom document theme.
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Customise the theme colours
9eme colours contain four text and background colours, six accent colours and two 

hyperlink colours. Some of the colours used in the current theme are shown on the �eme 

Colors button  and next to the 9eme name a�er you click on the �eme Colors button. 
When you change any of these colours to create your own set of theme colours and the 
colours that are shown in the �eme Colors button and next to the �eme Colors name 
will change accordingly.

1. In Word or Excel: on the Design tab, click Colors to select a colour theme. 

2. In PowerPoint: on the Design tab, in the Variants group, click More to select a 
colour theme.

3. Click on Customize Colors.

4. Under Customize Colors, on the Design tab, click the button of the theme colour 
element that you want to change.

5. Under Customize Colors, select the colours that you want to use. Under Sample, you 
can see the eAect of the changes that you make.

6. Repeat steps 4 and 5 for all of the theme colour elements that you want to change.

7. In the Name box, type an appropriate name for the new theme colours.

8. Click Save.

9. To return all theme colour elements to their original theme colours, you can click Reset 
before you click Save.
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Customise the theme fonts
9eme fonts contain a heading font and a body text font. When you click the �eme Fonts 
button , you can see the name of the heading font and body text font that is used for each 
theme font below the �eme Fonts name. You can change both of these fonts to create your 
own set of theme fonts.

1. In Word or Excel: on the Design tab, in the Document Formatting group, select a font.

2. In PowerPoint: on the Design tab, in the Variants group, select Fonts, then Customize 
Fonts.

3. In the Heading font and Body font boxes, select the fonts you want to use. 9e sample 
is updated with the fonts that you select.

4. In the Name box, type an appropriate name for the new theme fonts.

5. Click Save.
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Select a set of theme e8ects
9eme eAects are sets of lines and *ll eAects. When you click the �eme E%ects button , 
you can see the lines and *ll eAects that are used for each set of theme eAects in the graphic 
that is displayed with the �eme E%ects name. Although you cannot create your own set of 
theme eAects, you can choose the one that you want to use in your own document theme.

1. In Word or Excel: on the Design tab, in the �emes group, click E%ects.

2. In PowerPoint: on the Design tab, in the Variants group, select E%ects.

3. Select the eAect you want to use.
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Save a document theme
Any changes that you make to the colours, fonts or line and *ll eAects of a document theme 
can be saved as a custom document theme that you can apply to other documents.

In Word or Excel: on the Design tab, in the �emes group, click �emes, then Save 
Current �eme.

1. In PowerPoint: on the Design tab, in the �emes group, click More .

2. Click Save Current �eme.

3. In the File Name box, type an appropriate name for the theme. A custom document 
theme is saved in the Document �emes folder and is automatically added to the list of 
custom themes.
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Practice task 6

Set aside at least 30 minutes to use the features described in this section on a business document 

of your choice. Select your document and apply a document theme either using a prede�ned or 

custom document theme. You can use Microsoft Word, Excel or PowerPoint to do this. Practise 

changing the colours, fonts, and line and �ll effects that are used in the original document using the 

instructions in this section.
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Organising the content and structure of your  
document is the *rst step. Once you have designed a 
document, it needs to be formatted. For most 
documents, you will use a word-processing 
application, such as Microso� Word, for this task. 
Within this program there is a range of functions to 
help make your work more consistent. In this section 
you will look at the so�ware functions for:

• formatting text

• formatting styles

• headers and footers

• formatting tables

• merging and comparing documents, and 
tracking changes

• spellchecking and editing.

Format text
Formatting the text of a business document improves the overall appearance and 
presentation of the information. Although many so�ware programs have formatting 
options, this topic will only describe the functions of Microso� Word 2013.

Before going any further you need to *nd, or create, a Word document you can work on. 
Make sure it has at least eight paragraphs and is at least three pages long. It can be on 
any topic. It might even be an existing document from your workplace. You will use this 
document to complete some of the tasks. You will also be asked to work on it as you read 
through the topic.

If you do not have a document you can access, go to your local newspaper’s website and copy 
a section of a news story to work on.

2C Use a range of functions to 
design the document
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The Home tab

9e following functions are found on the Home tab.

The Font group allows you to change the font and size 

of selected text and numbers.

The Bold, Italic and Underline functions allow you to perform 

these actions on selected text.

The Highlight and Font Colour functions allow you to highlight 

text to stand out from the surrounding text or format selected 

text with a chosen colour.

The Home tab: paragraph group

9e Paragraph group enables you to select the following functions.

The Align Left, Centre, Align Right and Justify functions allow you to 

perform these actions on selected text.

The Numbering and Bullets functions allow you to add numbers or 

bullets within selected paragraphs.

The Decrease and Increase Indent functions allow you to indent the 

selected paragraph to the previous or next tab stop.

The Outside Borders function adds or removes a border around the 

selected text.



36
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU306
Design and produce business documents

Formatting styles
When using Microso� programs, the word ‘style’ refers to a set of formatting characteristics 
that you can apply to text, tables and lists in your document to quickly change their 
appearance. When you apply a style, you apply a whole group of formats in one simple task.

9ere are three types of styles you can create and apply, as shown below.

Paragraph style 

 └ A paragraph style controls all aspects of a paragraph’s appearance, 

such as text alignment, tab stops, line spacing and borders; it can also 

include character formatting. 

Character style

 └ A character style controls aspects of selected text characters within a 

paragraph, such as the font and size of text, and bold and italic formats. 

Table style

 └ A table style provides a consistent look to borders, shading, alignment 

and fonts in tables. 

Change a style

9e Styles group enables you to select or change the 
styles on an existing document. A style is created by 
selecting a number of diAerent formatting attributes 
and naming the style. For example, you might:

• select Arial for a font

• choose size 14 (pt) for a font size

• make the style right-aligned

• colour the text green

• name the style ‘Heading A’.

Your style, Heading A, can then be applied to any of 
the headings within your document without having 
to redo all the formatting selections.

Styles allow you to work quickly and consistently throughout a document. If you want to 
change the appearance of a style within the text, you simply modify the style properties and 
reapply the style.
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Quick styles

Quick Styles are sets of styles created to work together. Although a Quick Style set is likely 
to contain all the styles that you need to build a document, you may want to add a brand-
new style. You can also create additional styles, such as a new table or list style. Use your 
selected document to practise selecting styles using the following procedure:

1. Select the text that you want to create as a new style.

For example, perhaps you want the word ‘business’ to always appear as bold and red in 
your document.

2. On the Mini toolbar that appears above your selection, click Bold and Red to format the 
text.

3. Right-click the selection, point to Styles and then click Save Selection as a New Quick 
Style.

4. Give the style a name (for example, ‘Business’) and then click OK. 9e business style 
that you created appears in the Quick Styles gallery with the name you gave it, ready for 
you to use whenever you want text to be bold and red.
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Change existing styles

Alternatively, you may want to change the existing style of your document. For example, to 
change the attributes of the Heading 1 style, select text that has the Heading 1 style applied. 
Have a try on your existing document using the following steps:

1. Format the selected text with the new attributes that you want.

For example, you might decide that you want to change the size for the Heading A style 
from 16 pt to 14 pt.

2. On the Home tab, in the Styles group, right-click the style that you want to change; for 
example, Normal.

3. Click Update to Match Selection. All text with the style that you changed will 
automatically change to match the new style that you de*ned.

If you changed the styles in a document and the styles are not updating the way you 
expected, click the Styles dialogue box launcher, and then click the Style Inspector button 

 to *nd out whether text was manually formatted instead of formatted by using styles.

Headers and footers
Headers and footers are displayed at the top and 
bottom of each page in a document. 9ey usually 
contain information about the document. 9is can 
include a single line of text, multiple lines of text, a 
table or graphics. Headers and footers commonly 
contain information such as the document’s *le path 
(or code), date and page number.

O�en, there is a workplace standard about the 
information that goes in headers and footers. 
9is ensures that all readers are aware of certain 
information about the document, such as when it was 
written or where it is located on the server.

9e header and footer information can be contained 
within one section of the document, or can run 
through the entire document.
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Add a header and footer

You are now going to add a header and footer to your Word document. 

Follow these steps:

1. On the Insert tab, in the Header & Footer group, click Header or Footer.

2. Click the header or footer design that you want and type in text or select a built-in one.

Change a header and footer

You can insert or change text or graphics in headers and footers. For example, you can add 
page numbers, the time and date, a company logo, the document title or *le name, or the 
author’s name. To do this, follow these steps:

1. On the Insert tab, in the Header & Footer group, click Header.

2. Click Edit Header. 9is takes you to the Header & Footer Tools tab.

3. Insert text or graphics.

4. To save the header that you created to the gallery of header options, select the text or 
graphics in the header or footer, and then click Header as before. 9is time click Save 
Selection to Header Gallery.

If you want to change a header that you inserted, *nd the Headers & Footers group in the 
Insert tab, click Header as before, then select Edit Header.

You can also create a diAerent *rst-page header and footer or add diAerent headers and 
footers on odd and even pages. To do this, click on the appropriate selection in the Options 
grouping under the Header & Footer Tools tab.

To insert or change a footer, repeat these steps by selecting the Footer option in each step.
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Format tables
Tables are used to display information within a document. A table is basically a grid of 
rectangles (or cells). Into these you can add text, numbers and graphics.

A table can be customised to suit the requirements of your workplace. 9ey are frequently 
used in business documents to present *gures in rows and columns, or to show related 
information side by side.

Some examples of customisation are listed below.

How to customise tables in business documents

 • Adjust the width of the columns or the height of the rows.

 • Insert text, numbers or graphics in a cell and align it to the left, centre or 

right.

 • Fill a cell with a colour and/or a pattern.

 • Format the cell borders by adjusting the line style and thickness.

Insert a table
Use the Insert tab and select Table.

You are now going to insert a table in your Word document and enter some information. 
Follow these steps.

1. Move your cursor to the place in your document where you want to insert a table. If this 
is at the top of a page, leave enough space above the table for a label.

2. Select a table choosing at least three columns and four rows.

3. Enter information into your table. When you enter information into a cell it will wrap 
around to *t the width of the cell. 9e cell depth will expand to accommodate the 
information. Make sure each column of your table has a heading.

Practise moving your cursor from one cell to another by clicking the Tab key. To move your 
cursor back to the previous cell, just click on the cell, or press  
Shi2+Tab. To create a tab within a table, use Control+Tab.

You should now have a table that contains information. It might look like the 
following table.

Title Author Price

War and peace Leo Tolstoy $35.00

A tale of two cities Charles Dickens $40.00

Pride and prejudice Jane Austen $25.00

Little women Louisa May Alcott $30.00
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Select parts of a table

Before you can do anything with the information in a table, you need to be able to select the 
parts you want to format. One way to do this is to use the Layout tab under Table Tools, 
and then choose Select. 9is way you can select rows, columns and even the whole table 
with a single click of the mouse.

Following are some simple steps you can follow to select a group of cells.

Select block of cells

1. Move your cursor into the �rst cell to be included in the selection.

2. Click and drag over the required number of cells.

Select a row

1. Move your cursor to the left edge of the �rst row to be included in the 

selection.

2. Click and drag down the table to select the required number of rows.

Select a column

1. Move your cursor onto the top edge of the �rst column to be included in the 

selection. The cursor will change to look like a black arrow.

2. Click and drag across the table to select the required number of columns.

Select the whole table

1. Move your cursor to the top left-hand corner of the table. The cursor will 

show a four-arrow symbol.

2. Click the symbol and all cells in the table will be selected.
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Resize columns and rows
Depending on the type of information you have entered into your table, you may need to 
resize columns and rows. 9ere are two ways of resizing columns and rows. You can simply 
use your mouse to drag the table parts into the right size, or you can use the menu options.

You are now going to resize the columns and rows in your table. Follow these steps.

Using the mouse option Using the menu option

1. Move your mouse onto the right edge of a 

column or the bottom of a row you want to 

resize. Your cursor will change into a two-

headed arrow.

2. Click and drag the column or row to the 

required width or height.

1. Select a column to resize.

2. Select the Layout tab under Table Tools. 

Click on Properties.

3. Select the Column tab. Enter the column 

width into the Preferred width box. You 

may have to experiment with the correct 

size by looking at how the width change 

has altered your column.

4. Click on the Previous Column or Next 

Column buttons to change the width of 

adjacent columns.

5. Select a row and repeat these actions to 

modify its size.

Example: resize columns and rows

When you have �nished, your table might look like the following example, where the columns have 

been resized to suit the information and save space.

Title Author Price

War and peace Leo Tolstoy $35.00

A tale of two cities Charles Dickens $40.00

Pride and prejudice Jane Austen $25.00

Little women Louisa May Alcott $30.00
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Insert columns and rows
Business documents can alter as new information becomes available and old information 
becomes out of date. You may have to add or delete information entered into tables.

You are now going to insert a new row and a column into your table. Follow these steps.

Insert a row Insert a column

Place your cursor in the last cell of a table 

and press Tab.

OR:

1. Decide where you want to put the new 

information.

2. Select a row that is above or below the 

required position.

3. Select the Layout tab and the Rows & 

Columns group.

4. Select either the Insert Above or the 

Insert Below option.

5. Enter the new information.

1. Decide where you would like to put the 

new information.

2. Select a column that is to the left or right 

of the required position.

3. Select the Layout tab and the Rows & 

Columns group.

4. Select either the Insert Left or Insert 

Right option.

5. Enter the new information.

Delete columns and rows
You are now going to delete a row and a column from your table. Follow these steps.

Delete a row Delete a column

1. Decide which row you want to delete and 

place the cursor in that row.

2. Select the Layout tab and the Rows & 

Columns group.

3. Select the Delete option.

4. Select the Delete Rows option.

5. Decide which column you want to delete 

and place the cursor in that column.

6. Select the Layout tab and the Rows & 

Columns group.

7. Select the Delete option. 

8. Select the Delete Columns option.

Example: insert columns and rows

When you are �nished you should have a table with a new row and a new column of information, like 

the following example.

Title Author Price Code

War and peace Leo Tolstoy $35.00 E23

A tale of two cities Charles Dickens $40.00 E24

Pride and prejudice Jane Austen $25.00 E25

Little women Louisa May Alcott $30.00 E26

Tender is the night F Scott Fitzgerald $25.00 E27
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Insert or merge a cell
When working with tables, you may sometimes need to insert or merge a cell, perhaps to 
create room for a title or a heading. You are now going to insert and merge a cell in your 
table. Follow these steps.

Insert a cell Merge a cell

1. Select one cell in the �rst row of your 

table.

2. Select the Layout tab and the Rows & 

Columns group. Click the small arrow 

and select Insert Cells menu option. 

3. You should see the following dialogue 

box.

4. Select Insert entire row. Click OK.

1. Select your new row.

2. Select the Layout tab and the Merge 

group. Select Merge Cells menu 

option.

3. You should now have a row with one 

merged cell. Enter the title of your 

table into the new merged row. 

Example: insert or merge a cell

When you have �nished, your table might look something like the one below. This table has a title 

row created from a new merged cell.

Classic books

Title Author Price Code

War and peace Leo Tolstoy 35.00 E23

A tale of two cities Charles Dickens 40.00 E24

Pride and prejudice Jane Austen 25.00 E25

Little women Louisa May Alcott 30.00 E26

Tender is the night F Scott Fitzgerald 25.00 E27
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Format table content
To format the content use the Font group under the Home tab. Refresh your memory by re-
reading this information.

You are now going to format the content of your table using the following speci*cations:

• Title: Arial 14 pt, bold, centre align

• Column headings: Arial 12 pt, bold, le� align

• Content: Arial 10 pt, le� align

9e end result might look like the following example.

Classic books

Title Author Price Code

War and peace Leo Tolstoy $35.00 E23

A tale of two cities Charles Dickens $40.00 E24

Pride and prejudice Jane Austen $25.00 E25

Little women Louisa May Alcott $30.00 E26

Tender is the night F Scott Fitzgerald $25.00 E27

Add borders and shading
9e appearance of a table can be enhanced by adding borders and shading. Your 
organisation may have a preference for this type of formatting.

You are now going to apply a border and some shading to the title row of your table. First, to 
apply a border, follow these steps:

1. Select your title row.

2. Select the Design tab.

3. Select Borders from the Draw Borders group.

4. Your title row should now have a border similar to this Classic Books example.

5. Next, to apply shading, follow the same steps as before but select Shading from the 
Table Styles group. 
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Merge and compare documents, and track changes
Business documents are o�en written by a number 
of people. Multiple people can also be involved in the 
edit. Tracking changes, and merging and comparing 
documents are useful techniques to help with this 
process.

To complete the work in this part of the topic, you 
need two identical documents. Make two copies of 
the Word document you are currently working on, 
and call them Document 1 and Document 2.

9e Track Changes function is very useful if you 
want to revise or edit a document. It allows a person 
to insert, delete or move text or graphics and change 
the formatting. Microso� Word uses revision marks 
to show these changes. 9e changes can then be reviewed and accepted or rejected by 
someone else.

If you are going through this process in several copies of the same document (for example, 
there are several people involved in the edit), you can merge the diAerent copies and capture 
all the tracked changes into one document when they have *nished. 9is will give you one 
*nal document to edit at the end.

Track changes

You are now going to track the changes in your Word documents. 

Follow these steps:

1. Open Document 1.

2. On the Review tab, in the Tracking group, click the Track Changes icon. Click the 
Track Changes icon to turn Track Changes on or oA.

3. Make the changes that you want by inserting, deleting, moving or formatting text or 
graphics. You can also add comments. Word will track these changes as you make them. 
Save the changes and close the document.
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Merge documents

If you send a document for review to several reviewers, and each reviewer returns the 
document, you can combine the documents two at a time until all the reviewer changes 
have been incorporated into a single document.

1. Open Document 2, then on the Review tab, in the Compare group, click Compare.

2. Click Combine revisions from multiple authors.

3. Under Original document, click the name of the document into which you want to 
combine the changes from multiple sources. If you don’t see the document in the list, 
click Browse for Original .

4. Under Revised document, browse for the document that contains the changes by one of 
the reviewers.

5. Click More.

6. Under Show changes, select the options for what you want to compare in the 
documents.

By default, Microso� Word shows changes to whole words. For example, if you change 
the word cat to cats, the entire word cats will show as changed in the document and not 
simply the character ‘s’.

7. Under Show changes in, click Original document.

8. Click OK.

9. Word will merge all of the changes into the original document.

Word can store only one set of formatting changes at a time. 9erefore, when you merge 
multiple documents, you may be prompted to decide whether you want to keep the 
formatting from the original document or use the formatting from the edited document. If 
you don’t need to track formatting changes, you can clear the Formatting check box, which 
is a pull-down menu under Show Markup.
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Spellcheck and edit
All business documents should be checked for 
spelling mistakes. Spelling and grammar mistakes 
can distract readers from the work you have put 
into your documents, so you want to eliminate these 
mistakes. Word can check the spelling as you type, or 
you can run a spellcheck separately to check the text 
of an existing document.

As well as using this convenient tool, you must 
also do a manual proofread of every document. 
Unfortunately, the Word spelling function can miss 
words that are not appropriate even though they are 
spelled correctly.

Spellcheck as you type (AutoCorrect)

9e AutoCorrect feature can be a very useful function. It means that Microso� Word will 
automatically alert you to the words you misspell. You can use the AutoCorrect feature to 
correct typos and misspelled words, as well as to insert symbols and other pieces of text. 
AutoCorrect is set up by default in Microso� Word with a list of typical misspellings and 
symbols, but you can modify the list that AutoCorrect uses.

Beware of relying too heavily on AutoCorrect, particularly if you sometimes have to use 
unusual words that might look like errors.
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Spellcheck
You may prefer it if none of the documents you create 
show any spelling and grammar errors.

1. Click the File tab and then click Options.

2. Click Proo5ng.

3. To turn on or oA automatic spellchecking and 
automatic grammar checking for the currently 
opened document:

• Under Exceptions for, click on the name of 
the *le that is currently open.

• Select or clear the Hide spelling errors in 
this document only and Hide grammar 
errors in this document only check boxes.

4. To turn on or oA automatic spellchecking and automatic grammar checking for all 
documents that you create:

• Under Exceptions for, click All New Documents.

• Select or clear the Hide spelling errors in this document only and Hide grammar 
errors in this document only check boxes.

If you turn oA automatic spellchecking or automatic grammar checking for a *le 
that you share with other people, you may want to notify those people that you made 
this change.

Check grammar

Proofreading a document also means checking the grammar. Although you can do this by 
yourself, Microso� Word provides a useful grammar check that you can use.

9e grammar check identi*es errors in punctuation and the use of verbs. It also identi*es 
any misused words or long sentences. It can check grammar as you type, or you can run the 
grammar check a�er you have *nished writing the document. It can also be used to check 
the text of an existing document.

As well as using this convenient tool, you must also do a manual proofread of every 
document. Unfortunately, the suggestions made by the grammar-checking function are not 
always accurate, so you need to be careful about selecting changes.

Follow the same process for checking grammar as you did for checking spelling.
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Practice task 7

1. This is your �rst chance to work on the Word document that you have found or created. Use 

the following basic formatting functions to complete these tasks. You do not have to save the 

changes in your document.

 • Select three different fonts and three different font sizes. Apply these to part of your 

document.

 • Bold, italicise and underline some of the sentences in your document.

 • Use the numbering function to list some of the sentences in your document.

 • Add a border to one sentence in your document.

 • Highlight one sentence in your document and change the font colour of another.

2. Find the Page Number Format dialogue box. Format the page numbers of your document so that 

they are in lowercase Roman numerals; for example, i, ii, iii.

3. Use the table you have just inserted in your document to complete the following tasks:

 • Select three cells in your table.

 • Select two rows in your table.

 • Select one column in your table.

 • Select the whole table.

4. Resize some rows and columns.

5. Merge some cells.

6. Format the content in the table. 
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Input devices allow you to put information into a  
computer. 9ey include some things that you may or 
may not have heard of, such as touch screens, light 
pens, microphones, bar-code readers, fax/modem 
cards and joysticks. 9is unit, however, will only 
consider three main input devices used in an o1ce: 
the keyboard and numerical keypad, the mouse and 
the scanner. 9is topic will look at the keyboard and 
the mouse, and how these input devices can help you 
input information e1ciently.

Keyboard
9e keyboard is one of the primary peripherals 
on your system. Using a keyboard is the main way 
to input information for a business document. To use a keyboard e1ciently you need to 
be con*dent and streamline your actions. Practice makes perfect. 9e more familiar you 
become with your keyboard, the less hesitant you will be. 9ere are many online typing 
lessons available. Use a search engine to *nd a lesson that suits you.

Speed and accuracy can be improved if you are in a comfortable position. With less 
discomfort and fatigue you will be more alert and have better concentration and 
comprehension.

If you need to enter a lot of numerical data, activate the NumLock function on your 
keyboard by pressing the NumLock key. You will then be able to use the numerical keypad 
to the right of your keyboard.

2D Operate input devices
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Keyboard shortcuts

Another way to streamline your typing is to use the shortcuts on your keyboard. A shortcut 
is a combination of keys that allows you to travel more e1ciently around your system and 
the application you are using. For example, if you press Alt+Tab, you can switch between 
two open programs on your computer. 9is saves time locating the other program. Other 
shortcuts allow you to open your Start menu, quit a program, operate a program and cut, 
copy and paste content.

9e following table shows some useful Windows system shortcut key combinations and 
what they do.

F1 Help

Ctrl+Esc Open Start menu

Alt+Tab Switch between open programs

Alt+F4 Quit program

Ctrl+C Copy

Ctrl+X Cut

Ctrl+V Paste

Ctrl+Z Undo

Ctrl+B Bold

Ctrl+U Underline

Ctrl+I Italic

Shift+Delete Deletes an item immediately without placing it in the recycle bin

Mouse
9e mouse controls the cursor on your computer. It 
can be customised to suit your individual needs. 9is 
will improve the way you move around the screen.

If you customise the mouse settings, you will be 
able to choose a right-handed or le�-handed mouse 
button con*guration, adjust the double-click speed 
and turn on the ClickLock feature, which allows 
you to highlight or drag without holding down the 
mouse button.

Other mouse options allow you to change the pointer 
scheme (how it looks), adjust the pointer speed 
and adjust the acceleration rate. You can also show 
pointer trails, hide the pointer while typing and show 
the location of the pointer.

As with so many other features of your computer, just because you can do something does 
not mean that you necessarily should.
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Change your mouse properties

9e following steps will help you get to the Mouse Properties window.

1. From Start select Control Panel.

2. From the Control Panel, if the settings are in categories select Hardware and sound. If 
all settings are listed, go to Step 3.

3. Select Mouse.

You should now see the following Mouse Properties window.

Practice task 8

1. Practise using the following shortcuts on your computer:

 • Switch between open programs.

 • Bold and underline some content.

 • Cut, copy and paste content within a program.

2. Find the Mouse Properties window on your computer and change the properties of your mouse. 

Consider the following options.

 • In Pointers, adjust the scheme of your cursor. You may choose a larger cursor or one that is 

totally different to the one you have; for example, you can change it to a hand or a dinosaur.

 • In Pointer Options, display a pointer trail. Decide whether you would like the trail to be long or 

short.

 • In Buttons, adjust your double-click speed.
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Summary

1. Organisations need to identify, open and generate *les and records according to task 
and organisational requirements.

2. Organisations need to create, update and store their *les in suitable locations so that 
they can be easily accessed and maintained.

3. A business document is formatted to improve the presentation and appearance of 
information.

4. Before designing a document, you need to think about who you are communicating 
with and what information, or message, you are trying to convey.

5. Designing and formatting a document is about organising the structure and style to 
maximise the readability of the information.

6. A range of so�ware functions can be used to design, format, edit, merge, check and 
improve the presentation of a document.

7. Input devices allow you to put information into a computer. 9e mouse controls the 
cursor on your computer. To use a keyboard with speed and accuracy, you need to be 
con*dent and streamline your actions.



Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

55

Topic 2
Design the document

9is learning checkpoint allows you to review your skills and knowledge in designing the 
document.

Part A
1. Create a simple business document using Microso� Word. Format the document and 

write down the speci*cations of the formatting you choose. 
Use the following formatting functions:

• A style with a font and font size selection

• Bold, italic and underline functions

• Alignment function (at least once)

• Numbering or bullets

• Decrease or increase indent function

• Border (outside)

• Highlighting or font colour

• Insertion of a graphic

2. ‘In today’s business environment, the manager who has the relevant data *rst o�en 
wins, either by making the decision ahead of the competition, or by making a better, 
more informed decision.’

Describe how creating and updating records and *les allows management to make 
better decisions.

Learning checkpoint 2 
Design the document
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3. Imagine that you are training someone to use either a keyboard or a mouse. Design a 
cheat sheet or tips page with at least *ve points for your student to learn. Explain how 
you are going to teach each point.
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Part B
1. Design a document for either your organisation or an organisation that you are familiar 

with. If you are in the workplace, talk to a manager and decide on a business document 
that needs to be designed. If you are learning in a classroom or at home, design an 
absenteeism report for Happy Kids Primary School. 9e daily report should show which 
children are absent on a particular day, how many days they have been absent, antd 
whether there has been any information from the parents about why the child is absent. 
It might also show which classes the children are in.

a) Choose an appropriate so�ware application to design your document and give a 
reason for your choice.

b) Make sure that the document includes:

• appropriate design principles

• a range of formatting functions.

c) Describe how you used the principles and functions.

d) As you work, use the shortcuts on your keyboard and customise your mouse to 
whatever suits you best. Describe how you did this.

e) Identify any other *les or records you had to access in order to create this document. 
Explain where they are stored and how you accessed them.

f) Give the digital copy of your document a name. Explain how this meets the 
requirements of your organisation.
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2. Design a business document using the following content.

Dealing with stress

Take regular breaks

Exercise

Find someone to talk to

Reduce your tea and coffee intake

Every 20 minutes rest your eyes. Take a walk around the of�ce. Try to go outside at 

lunchtime. What are other ways to de-stress?

If you are sitting for long periods or working at your computer for extended periods, 

stretch your �ngers, arms, shoulders, neck and legs. Have a copy of exercises pinned 

up near your workstation.

Talking to someone about how you feel helps you let off steam. A good laugh also 

helps you to calm down and puts the reasons for your stress into perspective.

Tea and coffee are stimulants. Too much caffeine keeps you awake and hyperactive.

a) Use Microso� Word to design your document.

b) 9e design of the document is up to you, but try to include a graphic. You must also 
include:

• appropriate design principles

• styles

• table formatting

• headers and footers.

c) Describe how you used design principles and the functions listed.

d) As you work, use the shortcuts on your keyboard and customise your mouse to whatever 
suits you best.
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e) Identify any other *les or records you had to access in order to create this document; for 
example, *les from your place of study or at home. Explain where they are stored and 
how you accessed them.

f) Give the digital copy of your document a name. Explain how this meets the 
requirements of your place of study or home.



60
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU306
Design and produce business documents

Part C
Access and download employee-inquiry-sheet.docx either by scanning the QR 
code provided or at: http://chilp.it/5c045a8. 

Print oA a copy of the document as it is, before you make any changes. Now, use 
the document theme features to create a new document. Use the text from the 
form but apply either a prede*ned or a custom document theme to change the 
appearance of the entire document. Change the colours, fonts and any line and 
*ll eAects. Once you are happy your new form has a professional and modern 
look, save it and print it.

Once you have done this, go back to your original form and go through this 
process again but using a diAerent theme. Also add some graphics. Save and print this 
new form.

9en submit both versions of the form (together with the original) as part of your 
assessment.
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Producing a business document is a process. It involves a time line and a number of related 
tasks. It also involves a period of checking to make sure that the document has no errors 
and meets the requirements of your organisation.

Once a document has been produced, it should be appropriately named and stored. 9is 
might be as a hard copy, a digital *le or possibly as both. Either way, it must be in the right 
location so that others in the organisation can *nd it quickly and easily if required.

If you run into a problem while you are producing the document, you have a number of 
avenues for help. Use the help feature of your so�ware or go to the so�ware developer’s 
website for information. You could also refer to the user manual or a training booklet.

In this topic you will learn how to:

3A Complete document production within designated time lines

3B Check documents for style and layout

3C Store and save documents

3D Overcome basic di1culties with document design and production
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Whenever you have to produce a document, you need to plan a time line, which sets 
the schedule for a task or project. 9e time gives details of each task that needs to be 
accomplished to achieve that goal. It also describes who will complete each task and how 
long they have to do this.

Time lines are o�en set by other people in your organisation. To successfully meet these 
requirements, you need to de*ne the scope of the document, or how much of its subject 
should be covered. To do this successfully, you need to clarify who the audience is and 
exactly what the document is meant to say. 9en, you need to identify the tasks involved in 
producing the document. Next, work out how long it will take you to complete each task. 
By completing each task in the time you have allocated, you should be able to produce the 
business document on time.

Document production tasks may include:

• clarifying the document’s scope and audience

• researching the proposed content of the document

• accessing relevant information to include in the document

• writing the document

• formatting the document

• checking the document

• obtaining feedback on the document.

Realistic time lines
Once you have completed your document, think 
about whether the time line was realistic and 
achievable. If it was not realistic, make a note of this 
for future reference so you can allow more time to 
prepare it. If the time line was imposed on you by 
your organisation, and was without any Jexibility, 
take the time to talk to your manager or supervisor 
about this and suggest that the time line be revised in 
the future.

3A Complete document production 
within designated time lines
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Practice task 9

Read the case study, then answer the questions that follow.

Case study

Rada works as an administrative assistant. One of her duties is to produce documents for her 

manager. Rada has just been asked to produce the organisation’s newsletter. This is usually 

delivered in hard copy to internal and external clients.

The newsletter includes reports from a number of people in different departments. It also 

includes photographs and a report that Rada must write about the progress of a current project.

Rada makes a list of everyone who has to submit work for the newsletter. She informs each 

person about the work they need to submit and when it is required. Rada also asks a colleague 

to take the necessary photographs and have them ready one week before the release of the 

newsletter. She then has to write her report.

After that, Rada plans all of the tasks that still need to be done. She has to talk to colleagues 

who are involved in the project, draft and edit her report, and collect reports and photographs 

from colleagues.

1. Explain why the production of the newsletter needed a time line.

continued …
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… continued

2. Comment on Rada’s planning. What do you think was good or bad about her planning?

3. When there are a number of people involved in the production of a document, what kinds of 

things can go wrong?
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All organisations have processes and speci*cations  
to ensure their documents meet a certain standard of 
layout and style. Even though you may follow these 
requirements, you may still make mistakes. Because 
of this, all documents must still be checked for 
errors. As well as checking the style and layout of the 
document, you should also check spelling, grammar 
and punctuation. If you work with business 
documents you may o�en have to proofread and edit 
documents before they are printed, published or 
uploaded to the web.

Edit and proofread
When you edit a document, you modify and re*ne 
it to make sure that it meets with your organisational requirements. When you proofread a 
document, you identify and correct any errors in spelling, grammar and punctuation.

A checklist is o�en used to help people systematically go through the points that need to be 
considered before a document’s *nal dra�. Many organisations have their own checklists 
for proofreading and editing documents. Using a checklist will help you edit and proofread 
quickly and e1ciently. If your organisation does not have a checklist, perhaps you could 
develop one for it to use.

Here are some things to consider when editing and proofreading and how to address them.

Spelling

 └ Never rely on the spellcheck function on your computer. It only identi�es spelling 

errors, not incorrect use of words. Words may also be spelled in different ways; for 

example, American/Australian spelling for words such as organize/organise. Check 

the in-house style manual and ensure that you have selected Australian English as 

the language of your document (unless your organisation has a different policy). 

Grammar and punctuation

 └ Grammar and punctuation suggestions made by software applications are not always 

accurate. Check them yourself before adopting the suggestion. 

Style

 └ Styles should be consistent. Make sure headers and footers are correct and spacing 

is consistent throughout; for example, 10.30 am is always written in the same way. 

Check the in-house style manual.

Also consider using styles in your document to ensure and enforce consistency.

3B Check documents for style and layout
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Accuracy of numerical and statistical data

 └ Match your document with the original �gures you were given. It is very easy to make 

a mistake when entering a lot of numerical data into a document.

Edit and proofread tools and symbols

If you proofread using Word, you can use the 
Track Changes setting as discussed. Select 
the Review tab and Track Changes. Once you 
have activated this setting, your proofreading 
and editing changes will be highlighted. To 
permanently remove any changes, you must 
accept or reject them.

Editing and proo*ng symbols are used on hard 
copies of documents to indicate where changes 
should be made. 9ey are similar to shorthand, 
as they are much quicker and take up less 
space on the page than writing instructions in 
longhand.

9e Style manual for authors, editors and 
printers (John Wiley & Sons) is the standard 
text used by the Australian Government. It 
provides an extensive discussion of editing and 
proofreading symbols and their use, as well 
as other editing and formatting issues. Some 
organisations also have their own in-house style 
manuals or guidelines.

You should be familiar with both common and 
non-standard editing symbols so you can easily 
interpret the changes suggested by others.
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Practice task 10

This text is about digital cameras. Check for errors in spelling, grammar and punctuation to make 

it more readable. Then, rewrite the whole document with your corrections. Remember that spelling 

should be Australian, not American.

Digital Cameras

Digtal camera use an electronic sensor to tranform images (or vidoe) into electronic daata. 

Modern digital cameras are typically multifunctional and the same devise can take photorphs , 

vidoe and/or soundd.

In 2005 digital cameras was starting to pushe traditionl �lm cameras out of many markets. 

Shrinking device sizes have recently allowed miniaturized digitaal cameras to be included in 

multifunctional devices, such as ceel phones and persoonal digatal aids.

Video cameras

Proffessional video cameras such as those used in televiiosn and movie production, These 

typically have multiple image sensors (one per color) to enhance resoluution and color gamut. 

Professional video cameras usually do not have a built-in VCR or micropone.

Amature vido camers These are a combination of camera and VCR to create an all-in-one 

production unit. They generally include a microphone to record sound, and feature a small screen 

to watch video during �lming and playback.

Stille cameras

Digtal stilel camers are characterized generally by they use of +ash memory and USB or FireWire 

for storage and transfer. Most had a rear screen for reviewing PHOTOGRAPHS. They are rated in 

megapixels that is, the product of their maximumm reslution dimensions.
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Information is a valuable asset to any organisation. How information is saved and stored, as 
well as how it is protected, is central to its management.

Information contained in documents within an organisation is usually saved and stored 
on a computer that is connected to a server, allowing access to multiple users. A server is a 
computer that delivers information and so�ware to other computers linked by a network.

To enable everyone to log on to a server, the systems administrator issues each user with a 
user name. Each user must then create their own password. A username and password give 
access to the information needed to complete workplace tasks. DiAerent users will have 
access to diAerent information.

Data needs to be safeguarded against accidental or deliberate damage. Data loss is usually 
caused by either human error or system failure. Many organisations use a data cartridge 
or other device to back up the information on the server at the end of the day. 9is backup 
device can then be taken oA-site for safety.

Data storage
A data cartridge is a small magnetic tape that 
can hold a large amount of digital information. 
Information from an entire server can be saved onto 
a data cartridge and stored in a safe location. If any 
damage to the server (or the premises) occurs, a 
complete information backup is available.

A server is made up of lots of *les and folders. 
Organising this information helps users *nd what 
they want, when they want it. If you are saving 
information onto a server, make sure you know 
where to put it. Find out what your organisation’s 
policy is regarding information retention and 
deletion.

Electronic *les and folders should be periodically deleted, to ensure the most e1cient use of 
server space. Always ask for permission before you delete a *le.

3C Store and save documents
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Save a new Word document
When saving a document using Microso� O1ce 2013 applications, there are diAerent 
options compared to what was available in previous versions. When using Word, follow 
these steps to correctly save your document to avoid loss of data:

Click options in the Save As dialogue box to save a *le to a *le name, format and location 
that you specify. If you are saving a *le that has not been saved before, the Save As dialogue 
box appears automatically when you click Save.

9e following are the buttons and other options in the Save As dialogue box.

• Save in: In the list, click a location where you want to save a *le. Use the Save in list to 
move up one or more levels in the folder structure.

• Previous folder:  As you move through the folder structure in the Files list, this 
button allows you to go back to the previous folder that you viewed.

• Up one level: Click the folder title to the le� in the current folder structure to access the 
folder up one level.

• Delete: Press the delete button on your keyboard to delete the selected *le or folder.

• Create new folder:  Click this button to create a new folder within the 
current folder.

• Views:  Click the arrow next to this button to display *le and folder view 
options.

• File name: Type or select a *le name for the *le that you are saving.

• Save as type: In the list, click the *le format in which you want to save the *le. Most 
2013 Microso� O1ce system programs can save *les in more than one format, so you 
may need to select the format that you want.

• Page title: When you save a *le as a web page (under Web Page), Page title displays the 
title of the web page.

• Change title: When you save a *le as a web page (under Web Page), click Change title 
to display the Set Page Title dialogue box, where you can create or change the title of 
the web page.

• Tools: Click Tools to display a list of tasks that you can perform. 9e tools that are 
available vary depending on the program you are using.

• Save: A�er you determine the location, *le name and format of the *le that you are 
saving, click Save to save the *le.
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• Cancel: To go back to the *le without saving it, click Cancel.

Folder structures
Most organisations have folder structures. 9is allows staA to set up folders quickly and 
easily. Many organisations also have shared directories. 9ese are folders that have been 
placed on a network for certain groups of people to access. By using shared directories and 
naming standards, you can avoid losing or mis*ling electronic documents. Work is less 
likely to be duplicated and information can easily be exchanged. Using a shared directory 
also means that documents on the same or related subject are located together. 9is helps 
when you need to *nd or retrieve documents.

If your organisation has a shared directory, you need to decide whether a document should 
be placed in the directory or stay on your own hard drive. 9is is because some documents 
are for your use only and others need to be shared.

To set up a shared directory, you have to *nd the shared network drive. 9en go to the folder 
level. 9is is the *rst place to organise the directory. Folders have a tree-like structure that 
branches from a parent directory to sub-folders in a hierarchical structure.
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Example: directory hierarchy

Consider this example of a directory hierarchy.

In this structure the server has three folders for three separate workgroups: Group A, Group B 

and Group C. Group C has three major folders: Procedures, Personnel and Projects. The Projects 

Folder has three folders: Project A, Project B and Project C. The Project C folder has two documents: 

ProjectC_timelines.docx and ProjectC_research1.docx. The �le path for retrieving a document starts 

at the server and ends when the correct document is located. For example, to reach the ProjectC_

timelines.doc the �le path is: C:\GroupC\Projects\ProjectC\ProjectC_timelines.docx.

Digital storage
Paper documents can become damaged, yellowed 
and brittle. In addition, unless you are very careful, 
important documents can easily be torn, mis*led 
or accidentally thrown away. Storing a great 
many documents can also be expensive and some 
organisations prefer to store information digitally.

Digital storage saves paper and space. If the 
documents form part of a database, it also allows 
you to *nd speci*c information quite quickly. 9is is 
much easier than searching through the hard copies 
of the *les. Databases also provide management with 
powerful reporting tools. For example, statistical 
information can be gathered from a database to 
produce a detailed report.
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Hard-copy storage
It is common for documents stored digitally to also 
be stored in a hard-copy version. 9is is a safeguard 
against a catastrophic computer system failure. Hard-
copy storage requires physical space. It also requires 
a *ling system that uses consistent, simple and 
meaningful names similar to digital storage.

Hard-copy documents need to be kept up to date, 
and invalid documents need to be destroyed. 
Managing hard-copy documents properly is 
important, as storage space is valuable. Retention 
schedules are used to determine which documents 
need to be kept and for how long. Documents 
without permanent value may be scheduled for 
eventual destruction.

Retention schedules can help save space because only a limited number of records have 
long-term value. 9e development and implementation of a retention schedule also saves 
money, as it means that only records of enduring value will be permanently retained. Some 
documents need to be retained because of legal reasons; for example, taxation details need 
to be retained for at least *ve years.

Example: retention schedule

The following is a retention schedule.

Retention schedules for hard-copy documents

Credit card receipts and statements 2 years

Tax records 6 years 

Accounts records 6 years

Invoices 1 year

Client correspondence 2 years

Unsolicited CVs 6 months

The manual handling of incoming and outgoing correspondence requires a high level of organisation. 

Staff should be made aware of correspondence meant for them and outgoing correspondence 

needs to be sent on time. Most organisations have a distribution process involving opening, date 

stamping and �ling incoming correspondence. A collection point for outgoing correspondence should 

be established to enable all mail to be collected and posted on time.

The storing and �ling of incoming and outgoing faxes also requires a high level of organisation. 

Storage and �ling procedures will vary between different organisations. Increasingly correspondence 

is now sent electronically by scanners and email. Check what the procedures are within your 

organisation. It may be that fax copies are �led by date order in a dedicated folder and are kept for a 

speci�c period of time.
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Practice task 11

Read the case study, then answer the questions that follow.

Case study

Sean works as an of�ce administrator in a large organisation. His duties include �ling copies 

of information and backing up the server at the end of the day. His organisation uses a shared 

directory.

At the end of a busy day, Sean had to �le a number of folders in different locations. He 

remembered some of the locations, but had to guess the correct location for a couple of 

reports. After this, he was running late and decided not to back up the server.

The next morning, the reports Sean had �led were needed for an important board meeting. 

However, during the night a virus had infected the server, destroying all of the information.

1. Sean did not �le some of the folders in the correct place. What might be the consequence of this?

2. Sean did not back up information from the server. What were the consequences?

3. Explain why organisations need procedures for storing and securing information.

4. List four advantages of using a shared directory.
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Nothing in life is trouble free. You will o�en  
experience di1culties when designing or producing 
business documents. 9e business technology you are 
using might fail or the business so�ware might crash. 
Whatever the problem, it helps to have a plan for 
dealing with the unexpected. Organisations deal 
with di1culties in a number of diAerent ways. 9ey 
might have manuals or training notes. Some may 
even have a helpdesk set up to aid employees.

Use online help features
If you are working in a Microso� O1ce 2013 
application you can use the online help feature.

9e way you navigate the Help window is much the same way that you navigate the web in a 
web browser, such as Windows Internet Explorer. However, the Help window has additional 
features that a web browser lacks.

You can *nd help for Microso� O1ce programs in more than one place. Help is installed on 
your computer when an O1ce program is installed and you can get additional help content 
from Microso� O1ce Online. You can specify where you want to search for Help, and you 
can restrict the scope of your search to online or oSine or to a speci*c category within a 
program.

To choose between oSine and online topics, follow these steps.

Of�ine help Online help

In the main window of your Microsoft Of�ce 

program, open Help.

You can access Help by using a keyboard 

shortcut: press F1.

If you are using Access, Excel, PowerPoint 

or Word, click Microsoft Of�ce ‘program 

name’ Help , where ‘program name’ is the 

name of the program you are in; for example, 

Microsoft Of�ce Word Help.

If you are using InfoPath, Outlook, OneNote, 

Project, Publisher, SharePoint Designer, Visio 

or Clip Organizer, click on the Help menu, 

then click Microsoft ‘program name’ Help, 

where ‘program name’ is the name of the 

program you are in; for example, Microsoft 

Of�ce InfoPath Help.

On the Connection Status menu, which is 

located in the top left corner next to ‘Word 

Help’ of the Help window, click either Word 

Help from Of�ce.com or Word Help from your 

computer. Now whenever you open a Help 

window from any Microsoft Of�ce program, 

the Help window displays content from the 

source you chose. Your system administrator 

can disable the ability of the Help window to 

go online. If this happens, the Show content 

from Of�ce Online option is not displayed. 

For more information, contact your system 

administrator.

3D Overcome basic di7culties with 
document design and production
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Read manuals
Most equipment and so�ware comes with a user manual. 9ese describe the features 
and provide step-by-step instructions for use. Manuals include information about 
functions, maintenance, use, WHS issues related to the equipment or so�ware, and 
troubleshooting tips.

Manuals can come printed (as a brochure, book or booklet) or in digital format; for 
example, online.

9ere are many websites that have information about Microso� O1ce applications. 9ese 
usually contain frequently asked questions (FAQs) and give solutions to common problems. 
You can also download updates, tools and any *xes that Microso� has developed for its 
so�ware problems.

You might *nd the following websites helpful. 

Microsoft Of�ce

http://support.microsoft.com

This is Microsoft’s main site for 

�nding help with Microsoft Of�ce 

2013 programs. You can ask 

questions online and download �les 

including service packs, drivers and 

patches. You can also access the 

Microsoft Knowledge Base. This is a 

good source of help for all problems 

related to using Microsoft Of�ce 

2013.

Microsoft Of�ce Applications

http://of�ce.microsoft.com

This site provides resources for all 

Of�ce applications. It has news, 

announcements and useful �les for 

you to download.

Read training notes
9ere are many ways to learn about computer functions and so�ware packages. You can go 
to a training course to learn a particular computer function. Some suppliers also provide 
instructions on how to use their equipment.

You may have received some training when you started your job, but it should not stop 
there. It is important to keep up to date with technology. Try to locate the courses in your 
area that oAer so�ware training. 9ese courses usually provide a comprehensive set of notes 
that are worth keeping for future reference.

Tips for overcoming di1culties:

• Access printed manuals and training booklets in your workplace.

• Find websites that oAer advice on so�ware functionality.

• Ask colleagues for help and advice.
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Practice task 12

Read the case study, then answer the questions that follow.

Case study

Audrey is a personal assistant to the manager of a large organisation. One of her duties is 

to produce business documents using a variety of software applications. While producing 

documents Audrey often needs to use the Microsoft Of�ce Help to answer questions about 

software functionality. If she is puzzled by anything on the screen, she presses F1 and types in 

her query.

If Audrey experiences software function problems that cannot be solved using the Help, she 

uses Microsoft’s support website to �nd solutions. There is also a printed manual available in 

her workplace and she has copied the pages that she uses most frequently, keeping them in a 

Help folder on her desk.

1. Audrey sometimes has a software functionality problem. Where does she go for help?

2. When Audrey experiences a problem on the screen, what might she do other than use Microsoft 

Help or Microsoft Support websites?
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Summary

1. A time line sets the schedule for a task or project and gives details of each task that 
needs to be accomplished to achieve that goal. 9ey are o�en set by other people in 
your organisation and to meet these requirements you need to de*ne the scope of the 
document and know who your audience is.

2. All organisations have processes and speci*cations to ensure that their documents meet 
a certain standard of layout and style. Spelling, grammar and punctuation need to be 
checked carefully when proofreading.

3. Data needs to be safeguarded against accidental or deliberate damage by appropriate 
storage of documents and consistent saving and naming methods.

4. Hard-copy versions of documents need to be kept up to date, and invalid documents 
periodically destroyed.

5. Online and paper-based manuals and training booklets help overcome di1culties.
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9is learning checkpoint allows you to review your skills and knowledge in producing the 
document.

Part A
You have been asked to produce a business document by a certain date. To successfully meet 
this requirement, you need to de*ne the scope of the document.

1. What does ‘producing a business document by a certain date and de*ne the scope of the 
document’ mean?

2. How would you develop a time line to produce this document?

Learning checkpoint 3 
Produce the document
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Part B
Read the case study, then complete the tasks that follow.

Case study

Of�ce Temp is an organisation that supplies temporary of�ce staff. It has four work groups, 

each with two major areas of operations: Temporary Staff CVs and Client Information. Multiple 

�les need to be stored in folders representing each area of operation. All staff CV �les must 

start with CV and all client information �les must start with CI. The work groups have a shared 

directory on the C drive.

1. Design a hierarchical folder structure to suit O1ce Temp. Refer to the example in this 
topic if you need help. Make sure you choose folder names that are consistent, simple 
and meaningful.
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2. Use the information on editing marks in this topic to translate the following edit marks. 
Reproduce the following text with all edits corrected.
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Part C
1. Produce a business document, such as a newsletter or a report. 9e topic is up to you, 

but you must discuss it with your trainer before you start. To develop the document, 
make sure that you do the following:

• Scope the document to decide exactly what information it will contain.

• Identify every task that must be done to produce the document.

• Prepare a time line and allocate some time for every task.

• Develop the document.

• Proofread and edit the document for spelling, grammar and punctuation.
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2. Store the document in an appropriate way. Explain how you have done this.

3. Describe any di1culties you had when producing this document and explain how they 
were overcome.
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Once you have selected and prepared your resources, and then designed and produced your 
document, you will *nalise it. 9is entails a *nal proofreading, making any modi*cations 
necessary, naming and storing the document, exiting the application correctly and *nally 
printing and presenting the document.

9ese processes must take place in a logical sequence to avoid missing any errors, or losing 
or damaging any data, and to make sure you produce a professional document according to 
the requirements of your organisation.

In this topic you will learn how to:

4A Proofread the document prior to *nal output

4B Make modi*cations

4C Name and store the document and exit the application

4D Print and present the document
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In the previous topic, you learnt about the importance of checking a document for errors in 
its style and layout as well as spelling, grammar and punctuation. You looked at editing and 
proofreading tools and symbols, and explored ways to ensure the document is consistent 
with organisational requirements. Proofreading means ensuring your *nal text is free of 
mistakes. Using the spellchecking function alone is not su1cient; it does not pick up the 
incorrect use of words, and cannot identify situations where you have typed a word that 
is pronounced the same way as the word you wanted but means something diAerent (a 
homonym).

Now you will look at some further techniques for developing your proofreading skills to 
enable you to check your document for readability, accuracy and consistency in language, 
style and layout prior to the *nal output, which is the completed version of your *nal 
document, either printed or electronic.

Tips and tricks for proofreading:

• Print a copy of the document; it is easier to detect errors on a page than on screen.

• Read it slowly; one word at a time, covering the later words so that you do not look 
ahead or look for meaning.

• Have someone else read it.

• Read it out loud and silently.

• Read it backwards, in segments, so aspects other than meaning, such as spelling errors 
and layout, stand out more.

• Use the spelling and grammar checking functions at *rst proo*ng – but don’t depend 
on them entirely.

• Double-check any numbers.

• Read it upside down to focus on typography.

• Allow time between completing the *nal copy and proofreading; then look at it with 
fresh eyes.

• Proofread when you’re most alert.

• Don’t try to proofread all types of mistakes at once. During each read-through, focus on 
diAerent aspects.

• Avoid distractions. 

• Watch out for homonyms. 9ese are words that share the same spelling or 
pronunciation but have diAerent meanings.

• Watch out for contractions and apostrophes.

• Make a note of your most common errors so you can pick them up faster next time, 
possibly by using the *nd and replace function.

4A Proofread the document prior to 3nal output
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Types of proofreading
9ere are three types of proofreading as outlined here.

Comparison

A comparison proofread may not be applicable to every task. It applies to 

tasks where you have an original document you are copying from. This could 

be your own handwritten notes or printed notes with changes highlighted on 

them. A comparison proofread requires a word-for-word, character-for-character 

comparison of the new document and the old document. This is to ensure that 

the exact same words and punctuation are in both documents. 

Content

A content proofread focuses on the new document. The purpose is to look for 

correct sentence structure, logic, spelling, punctuation, consistency and factuality. 

The purpose of the content read is to make sure the document is correct and 

reads well; that is, readability. Readability refers to how well the document +ows; 

for example, whether there are enough new paragraphs to separate different 

parts of the content. A good trick to check a document’s readability is to read 

it out loud to yourself or to someone else. Take time to read through it several 

times. Another strategy is to have someone else read it and give you feedback. 

Another person will be in a better position to evaluate whether your sentences 

make sense or not. 

Format

A format proofread is the �nal proofreading. You are looking for a correct and 

consistent format in the document. There are certain formatting conventions that 

are often followed when preparing business documents such as a business letter. 

A good starting point for a format proofread is to scan the edges of the document 

and look for anything that is out of alignment. Then look at the overall page, and 

check whether it looks balanced. For example, is the space between paragraphs 

consistent? Are all paragraphs aligned to both the left and right margins? Check 

page numbers, headers and footers, if applicable.

Allow yourself a reasonable amount of time to work through each of these 

proofreading stages in order to produce the most professional outcome.

When you are proofreading a business document you might like to consider the 

following tips to assist you and make it easier when proofreading documents at 

future times.
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Proofreading tips
Some useful tips for proofreading:

• Use a bright coloured highlighter so that your 
corrections stand out.

• As well as marking the errors, mark every page 
that has an error on it so you can skip over the 
pages that don’t have any. Use either the upper or 
lower right-hand corner so you can Jick through 
the document quickly.

• Point with your *nger to read one word at a time.

• Read something else between proofreading. 9is 
helps to clear your head of what you anticipate 
reading and allows you to read the actual text.

• Check that numbers match their references in the 
text and are sequential (in order).

• Have a good dictionary and a thesaurus at hand.

Practice task 13

Proofread and edit this business document. You need to consider its readability, accuracy and 

consistency of language, style and layout. Reproduce the document, proofread it using appropriate 

techniques, and print it. Make a note of the changes you have made as this may help when 

proofreading and editing documents in the future.

Using software functions

You are now going to learn how to prepare an electric presentation. You will need to have excess to 

a computer and Microsoft PowerPoint. The operating system used in this unit is Microsoft Vista and 

the software is PowerPoint 2013. To design your present you need to develop an understanding of 

the software functions and features of PowerPoint (ie what the program allows you to do.) This will 

enable you to prepare a present that has a consistent style and a visual impact.

In this part of the unit you will:

 • create a slide show

 • apply a design template

 • add content

 • right or draw on slides

 • apply a style

 • create handouts and speaker notes.

PowerPoint uses slides to build an electronic presentation. A slide is a single frame in a presentation 

and a presentation comprises a group of slides. Before you start to design your presentation, it 

will be helpful to become familiar with the names of sum of the PowerPoint functions. Look at the 

functions and descriptions in the following table.

continued …
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… continued

Function Description

Placeholders Boxes with dotted lines that appear when you create a knew slide.

Slide Master Allows you to change the style of text and have the style re+ected throughout 

the hole presentation

Notes Master Allows you to create notes when working on your presentation.

Importing other 

applications

Allows you to import information from other applications such as Word or 

Excel, and add them too your presentation.

Handout Master Allows you to create handouts to go with you’re presentation.

Colour schemes Is a selection of background colours that you can apply too your 

presentation.

Templates Templates contain colour schemes and text formatting to design a 

presentation with a particular look.

Planning your presentation

As previously discussed, you need to plan your presentation before you begin. This means working 

out:

 • what the presentation is about (the purpose)

 • how the presentation is for (the audience)

 • how you are going to present the information? (the method).

Then you need to prepare the content of your presentation. The best way to do this is to create a 

storyboard to help you map out the information you are going too present.

continued …
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… continued

continued …
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Once the document has been proofread and errors or inconsistencies identi*ed, the 
document will need to be modi*ed (or edited) accordingly. 9e modi*cations you make will 
depend on what computer so�ware you are using, what sort of business document it is and 
what kind of modi*cation.

9e way you make modi*cations to a business document will depend on the so�ware you 
are using. Commercial accounting packages such as Quicken and Mind Your Own Business 
(MYOB) have their own customised way of editing. If you are unfamiliar with this part of 
the package consult the manual, the online help or a work colleague.

You have already learnt about the edit feature of tracking changes in Microso� O1ce 2013, 
as well as making design and layout modi*cations to text and tables. Another common way 
of making modi*cations to an existing document is to scan it and then modify it.

Types of modi�cations

 • Spelling and grammar

 • Style

 • Layout

 • Theme

 • Graphics

 • Table layout

 • Table formatting

 • Headers and footers

Edit a scanned document
Scan your document according to the instructions 
for your scanner.

Before you continue, convert the *le that the scanner 
created to TIFF, which means tagged image *le 
format. You can use Paint or another program to 
convert the *le. 

You now have a document that you can edit. Be sure 
to save the new *le so you don’t lose your changes.

Be aware that scanning a document does not always 
give a perfect result. Watch for documents that use 
unusual typefaces (fonts), as well as for confusion 
between similar looking letters and numbers. 
9e upper-case letter O and the numeral 0 can be 
confused, as can the number 1, lower-case l and even upper-case I.

4B Make modi3cations
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Enable editing for a document that is marked as 3nal
You may need to modify a document that has been marked as *nal at a previous time, and 
therefore is only accessible in read-only format.

In Microso� O1ce 2013 programs, documents in read-only format have a yellow MARKED 
AS FINAL banner at the top of the document to discourage editing. But you can override 
the read-only format by selecting the Edit anyway button.

Set the Mark as Final command for a document that has been *nalised as follows.

1. Open the document that has been approved as *nal.

2. Click the File tab, select Info and then click on Protect Document to select Mark as 
Final.

Find and replace function
Another useful modi*cation feature of Microso� O1ce programs is the Find and Replace 
option. 9is is used to *nd and replace text, formatting, paragraph marks, page breaks and 
other items. You can also *nd and replace noun or adjective forms or verb tenses. Just be 
careful when using the Find and Replace all feature that you don’t create problems such as 
incorrect case. It is good practice to replace one word at a time rather than replace all.



94
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU306
Design and produce business documents

Find text
You can quickly search for every occurrence of a speci*c word or phrase.

1. On the Home tab, in the Editing group, click and select Find.

2. In the Search Document box, type the text that you want to search for.

All instances of the word or phrase will be highlighted in the document.

For more search options or to turn oA the highlighting, in the Home tab click on the Find 
drop-down arrow and select Advance Find…

Find and replace text
You can automatically replace a word or phrase with another; for example, you can replace 
Acme with Apex.

9e replacement text will default to using the same capitalisation as the text that it replaces. 
For example, if you search for AKA and replace it with Also known as, the result will be 
ALSO KNOWN AS. You can override this by clicking More and selecting Match case from 
the list of options.

1. On the Home tab, in the Editing group, click Replace.

2. Click the Replace tab.

3. In the Find what box, type the text that you want to search for.

4. In the Replace with box, type the replacement text.

5. Do one of the following:

• To *nd the next occurrence of the text, click Find Next.

• To replace an occurrence of the text, click Replace. A�er you click Replace, it will move 
to the next occurrence of the text.

• To replace all occurrences of the text, click Replace All.
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Find and replace speci3c formatting
You can search for and replace or remove character formatting. For example, you can search 
for a speci*c word or phrase and change the font colour, or you can search for speci*c 
formatting such as bold and change it.

1. On the Home tab, in the Editing group, click Replace.

2. To search for text with speci*c formatting, type the text in the Find what box. To *nd 
formatting only, leave the box blank.

3. Click Format, and then select the formats that you want to *nd and replace.

4. Click the Replace with box, click Format and then select the replacement formats. If 
you also want to replace the text, type the replacement text in the Replace with *eld.

5. To *nd and replace each instance of the speci*ed formatting individually, click Find 
Next and then click Replace. To replace all instances of the speci*ed formatting, click 
Replace All.

Find and replace paragraph marks, page breaks and 
other items
You can search for and replace special characters 
and document elements such as tabs and manual 
page breaks. For example, you can *nd all double 
paragraph marks and replace them with single 
paragraph marks.

1. On the Home tab, in the Editing group, click on 
the Find drop-down menu.

2. Select Advanced Find.

3. Click More, then click Special and then click the 
item that you want.
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Make modi3cations in Microsoft Excel
Obviously there are many reasons to make modi*cations in all of the programs you 
may use.

9is is a common modi*cation made when using Microso� Excel 2013. It is used to edit the 
contents of a cell. 9is can be done either directly in the cell or in the formula bar.

1. To place the contents of a cell in editing mode, click the cell that contains the data 
that you want to edit, and then click anywhere in the formula bar. 9is positions the 
insertion point in the cell or formula bar. To move the insertion point to the end of the 
cell contents, click the cell and press F2.

2. To edit the cell contents, do any one of the following:

• To delete characters, click where you want to delete them and then press Backspace, or 
select them and then press Delete.

• To insert characters, click where you want to insert them, and then type the new 
characters.

• To replace speci*c characters, select them and then type the new characters.

• To turn on Overtype mode so that existing characters are replaced by new characters 
while you type, press Insert.

• Overtype mode can be turned on or oA only when you are in editing mode. When 
Overtype mode is turned on, the character to the right of the insertion point is 
highlighted in the formula bar, and it will be overwritten when you type.

• To start a new line of text at a speci*c point in a cell, click where you want to break the 
line, and then press Alt+Enter.

3. To enter your changes, press Enter. Before you press Enter, you can cancel any changes 
that you made by pressing Esc. A�er you press Enter, you can cancel any changes that 
you made by clicking Undo  on the Quick Access Toolbar.

Change column width

A cell may display ##### when it contains data that has a number format and that is wider 
than the column width. To see all text, you must increase the width of the column.

How to change the column width:

1. Click the cell you want to change the column width for.

2. On the Home tab, in the Cells group, click Format.

3. Under Cell Size, do one of the following:

• To *t all text in the cell, click AutoFit Column Width.

• To specify a larger column width, click Column Width and then type the width that 
you want in the Column width box.
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How to wrap text in a cell

You can display multiple lines of text inside a cell by wrapping the text.

1. Click the cell in which you want to wrap the text.

2. On the Home tab, in the Alignment group, click Wrap Text.

If the text is a single long word, the characters won’t wrap; you can widen the column or 
decrease the font size to see all the text. If not all text is visible a�er you wrap the text, you 
may need to adjust the height of the row. On the Home tab, in the Cells group, click Format 
and then under Cell Size click AutoFit Row.

Practice task 14

If you have access to a scanner, try scanning the document in the previous practice task and then 

making modi�cations to correct it.

If you don’t have access to a scanner, select a document of your choice and practise using the �nd 

and replace functions described in this section. Also try marking your document as �nal and then 

allowing it to be edited.
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As well as placing folders and *les in the appropriate  
places, you also need to give them appropriate names. 
Naming methods should be kept consistent, simple 
and meaningful. Appropriate naming conventions 
help in the identi*cation and retrieval of documents.

Your organisation may already have established 
guidelines for naming *les that you should use as 
well as requirements for backing up data.

Windows Explorer is a *le management application 
designed to manage *les, folders and drives. 9is, 
combined with the application program you are 
using, enables you to manage *les e1ciently and 
logically.

Use meaningful 3le names
When using Microso� programs and Windows Explorer, *le names are listed alphabetically 
based on the *rst word. 9erefore, this *rst word has to be meaningful. For example, if you 
have a folder of proforma documents (such as fax forms, business letters, order forms and 
letterheads), it would be logical to name them this way, rather than by Pro-forma fax and 
Pro-forma letterhead as then they would all begin with the letter ‘P’.

Alternatively, within a letter folder you may use numbers as *le names. For example, if 
you write several letters to the one client you may name them Letter 1 Jack Smith, Letter 2 
Jack Smith followed by the date. Numbering *les is very common for organisations such as 
insurance companies, who may name the document according to a policy number.

If you are preparing documents for regular meetings, you may like to label them with 
the date or number of the meeting. Some people use a standard date format; for example, 
20080401BoardAgenda (for a document dated 1 April 2008) or, particularly for monthly 
meetings, simply use the year and month; for example, 2008-04BoardAgenda. It is better to 
use the number rather than the name of the month, if you want the documents to appear 
sequentially in your list of *les.

Whenever you have a series of related *les, it is a good idea to use the same or similar 
*le names for each *le. Make sure that you can easily distinguish them from one 
another, though!

4C Name and store the document, 
and exit the application
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Save documents to avoid loss of data
A�er creating or modifying an electronic document, 
you need to save it to ensure that your data is not 
lost when you exit the so�ware application. Data 
loss happens when a document is not saved correctly 
or frequently or when the computer program 
stops performing its expected function. O�en the 
oAending program may simply appear to freeze. 
All computer users have experienced data loss at 
some time, or have been unable to access data from 
a previously functioning computer. Data may not 
have been saved regularly or correctly, or it may have 
been accidentally erased or corrupted and made 
inaccessible. 9e most common cause of data loss is 
human error.

Data loss can also occur if someone else tampers with your work. If you are working 
on a document at your workstation, you should always lock your computer, or exit the 
application, before leaving your workstation unattended.

Try to work on one document at a time. If you need to have multiple applications 
open, make sure you save the documents that are no longer needed before closing the 
applications. 9is will help your computer to work more quickly and prevent data loss if the 
computer fails.

Other causes of data loss include virus damage, operating system or application so�ware 
bugs and failed upgrades.

Exit applications safely
When exiting an application, you need to ensure that you understand the method of saving 
prior to exiting that is applicable to the program you are using. Always save prior to exiting 
and ensure that all windows that are open in the program are closed correctly prior to 
closing the program. Never shut down your computer until all opened applications have 
been closed properly.

You can exit Microso� O1ce 2013 programs either by selecting the File tab and choosing 
Exit, or by clicking on the close button X at the top right-hand corner of the window.
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Backup data
9ere are various methods of backing up (storing) your document. 9ese are outlined here.

DVD Write drive 

 └ Data is copied onto DVD.

USB drive 

 └ Also known as a +ash drive. This is a plug-and-play portable storage 

device that uses fast +ash memory and is lightweight and portable. 

These are commonly used in place of a DVD. When a USB drive is 

plugged into a USB port, the computer’s operating system recognises 

the device as a removable drive and assigns it a drive letter. Some USB 

devices have password protection or other security features.

External hard drive 

 └ A portable storage device that can be attached to a computer through a 

USB or FireWire connection, or wirelessly. External hard drives typically 

have high storage capacities and are often used to back up computers 

or serve as a network drive.

Cloud computing 

 └ The practice of using a network of remote servers hosted on the internet 

to store, manage and process data, rather than a local server or a 

personal computer.
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Practice task 15

Read the case study, then answer the questions that follow.

Case study

Matthew has retired from an organisation after working there as an administrative assistant 

for 10 years. At work, he had been responsible for two areas: Accounts and Projects. The day 

after he retired, somebody urgently needed a �le that Matthew had created and stored. The 

�le contained vital accounting information. It was discovered that Matthew had saved over 500 

�les in a variety of folders and the �le could not be located. The folders had names such as 

Folder1 and Folder2 and the �les had names such as august1.docx and march2.docx.

1. Describe why Matthew’s folder and �le naming system failed.

2. Matthew was responsible for two areas. What folder names could he have used to make sure 

that �les were placed in the correct folder?

3. Describe the consequences of placing folders and �les with unclear names on shared directories.

4. List four reasons for data loss.
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Once you have done a *nal proofread of your  
document for spelling, grammar, consistency and 
style, you are ready to print it. 9e information you 
print may be for your own use or for someone else in 
the organisation. If you are printing materials for 
someone else, make sure that you discuss what they 
need before printing, as alterations may be required.

Also be aware of organisation requirements for 
printing and presenting documents. An organisation 
may have a policy that business documents must 
be printed double-sided (that is, using both sides 
of the paper) or that certain business documents 
are printed with a glossy, coloured front page and 
remaining pages in black and white. Make yourself 
familiar with your organisation’s requirements for 
printing and presentation.

If your document has been prepared using PowerPoint you can print out handouts, speaker 
notes, outlines or transparencies. If your document is a Publisher or Word document you 
will likely be printing out the completed document onto paper, card or transparencies and 
may also print envelopes.

Print from Microsoft Word
To print a Microso� Word document, click File tab and select Print from the menu on 
the le�.

You may need to use the following options in the Print options.

Print

Print icon Click here when you are ready to print, after checking that the Printer 

and Settings are correct. 

Copies Click the arrows to increase or decrease the number of copies that 

you want printed. You can also type in the number of copies you 

require in the box.

Printer

Printer Select your printer from the drop-down list.

Print to File This option is at the bottom of the Printer drop-down menu. Select 

this to create a �le from the document instead of routing it directly to 

a printer. The �le is saved with print formatting, such as font selection 

and colour speci�cation in a .prn �le that can be printed to another 

printer.

Printer Properties This link will bring up the Printer Properties dialog box.

4D Print and present the document
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Settings

Print All Pages In this drop-down menu, you can choose to print the entire document, 

the current page or speci�c pages to print. You can also choose to 

print only odd or even pages.

If Print Markup is checked, then all the tracked changes made to the 

document will be printed on the right-hand side of the page. You can 

also choose to print other document information such as a list of 

styles used or the �le name, author and title.

Pages In this box enter the page range you wish to print.

Print One Sided In the drop-down menu, select if you want to print on one side, print 

on two sides or manually load the printer to print on two sides. 

Collated If you collate the printing and print three copies of a document, you 

will print pages 1,2,3,1,2,3,1,2,3 and so on. If you choose uncollated, 

you will print pages 1,1,1,2,2,2,3,3,3 and so on.

Orientation In this drop-down menu, select either portrait orientation or 

landscape orientation.

Paper Size In this drop-down menu, select the paper size you will be printing on.

Margins In this drop-down menu, you can select from a range of margin pre-

sets such as normal, narrow, moderate, wide, mirrored and Of�ce 

2013 default. You can also click on Custom Margins, which will take 

you to the Page Setup dialog box.

Pages Per Sheet In this drop-down menu, click the number of pages you want to 

appear on one printed page. You can also choose to Scale to Paper 

Size.

Page Setup Click this link to launch the Page Setup dialog box for more page 

setup options.

Print from Microsoft Excel
If you are printing from Excel, you will be printing worksheets or workbooks. You may 
wish to preview your worksheets prior to printing to ensure the layout is satisfactory. For 
example, to make sure that the worksheet *ts on one page. Follow these steps:

1. Click the worksheet that you want to preview before you print it.

2. Click File tab and select Print from the menu on the le�.

3. 9e Print preview will automatically be shown on the right-hand side.  
Keyboard shortcut – You can also press Ctrl+F2.

4. To preview the next and previous page, scroll up or down.

5. To view page margins, click on the Show Margins button  under Settings.

9is displays the margins in the Print preview. To make changes to the margins, you 
can drag the margins to the height and width that you want. You can also change the 
column widths by dragging handles at the top of print preview page.

To make page setup changes, use the drop-down menus under Settings. You can also click 
on the Page Setup link to launch the Page Setup dialog box and then select the options that 
you want on the Page, Margins, Header/Footer, or Sheet tab.
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Print handouts in Microsoft PowerPoint
In PowerPoint you can print your slides as handouts for the audience. You can also choose 
how many slides you would like on each handout. 9e following method will print out an 
exact replica of your presentation slides.

Follow these steps:

1. Open the presentation for which you want to print handouts.

2. Select the File tab, then click Print.

3. Click on the Full Page Slides option. 9is will bring up a drop-down menu where you 
can select the handout option you want from the list. 
9e Handouts (3 Slides Per Page) format in PowerPoint provides lines for the audience 
to take notes. 
You can choose whether you want to print handouts in colour, grayscale or black and 
white. Go to the File tab and click Print. 9e last drop-down menu lets you make this 
selection.

4. To specify the page orientation, click the Portrait Orientation drop-down menu, and 
then click Landscape or Portrait.

5. Click Print.

Printing tips
9ere are many devices and programs required to 
perform a print operation and sometimes these don’t 
work as they should.

Before printing your document, make sure that it has 
been saved securely. Also make sure that the printer 
is properly connected and ready to receive print jobs. 
Replace toner according to the supplier’s instructions 
and make sure the correct paper is used.

If you are printing onto preprinted paper, such as 
letterhead or certi*cates, make sure it is inserted the 
correct way so as to avoid wastage. Also remember to 
remove any spare preprinted sheets so that the next 
user doesn’t waste these.



Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

105

Topic 4
Finalise the document

Presentation of the document
9e *nal presentation of your document will be determined by the type, size and style 
of your document and the requirements applicable to your organisation or client. No 
matter which form of *nal presentation is used, the most important thing is that it is clear, 
accurate, a consistent style and professionally presented. Following are some of the various 
ways that business documents can be presented.

Electronic

 • Electronic presentation using 

PowerPoint or any program 

using the display provided by a 

data projector

 • Presentation using 

transparencies and an overhead 

projector

 • Electronic presentation via 

email or website

Hard copy

 • Printed, collated and stapled 

documents

 • Bound book presentations

 • Printed documents within a 

display folder

 • Printed documents in a 

presentation wallet displaying 

information unique to the 

organisation such as logo, 

letterhead and organisation 

details

 • Printed and laminated 

documents

 • Printed reports in a ring binder 

or clipboard.
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Practice task 16

1. Describe the appropriate methods of presentation to present reports such as projects or 

résumés.

2. How do you select to print only four consecutive pages in a 10-page document?

3. If you are printing a four-page word document, how do you print all four pages onto the one sheet 

of paper?
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Summary

1. Prior to the *nal production of your document, you need to carefully proofread it for 
readability, accuracy and consistency of language, style and layout.

2. 9ere are many useful and practical tips to assist you in proofreading.

3. Once identi*ed, the errors or inconsistencies in the proofread document, will need to 
be assessed and modi*ed as appropriate. 9e modi*cations you make will depend on 
the computer so�ware you are using, the sort of business document it is and the type of 
modi*cation being considered.

4. Folders and *les need to be given meaningful names to make sure they can be easily 
accessed in the future. Naming methods need to be kept consistent. Your organisation 
may have existing conventions for naming and storing documents.

5. 9e so�ware application needs to be exited systematically to avoid damage or loss 
of data. Damage or loss can occur if the document has not been correctly saved or 
there is a system failure. However, the main cause of data loss is human error. Backup 
procedures need to be followed methodically.

6. Business documents may be printed onto paper and presented in a variety of diAerent 
ways such as booklets or laminated documents. Alternatively, documents may be 
presented electronically as an email, on a data projector screen or an overhead projector.

7. No matter which form of *nal presentation is used, the critical aspect is that the 
information in the document is clear, accurate, in a consistent style and professionally 
presented.
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9is learning checkpoint allows you to review your skills and knowledge in *nalising the 
document.

Part A
Explain what methods you use within your organisation for printing and presenting 
business documents. Provide samples if available and appropriate.

Learning checkpoint 4 
Finalise the document
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Part B
Using a so�ware application of your choice, prepare a document that provides a list of tips 
for best-practice proofreading. You can refer to websites or to other reference material. 
Your document should be in a format that is readable, accurate and displays consistency of 
language, style and layout.
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